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Introduction  
Primafact 6 takes case development to the next level.  Primafact is designed to support more 

efficient document review and case preparation. 

Primafact provides several main benefits to litigation teams:  

 Improved efficiency in managing litigation documents 

 Superior access to case documents & review notes 

 Flexible review & reporting options 

Primafact 6 enhances efficiency at every stage of review, connecting evidentiary analysis to case 

documents for better preparation and case understanding throughout the life of the case. 

 

Why Primafact?  

✓ Better document access with all documents related to a matter organized in one central 

location 

✓ User-determined document positioning in Binder view, for controlled case narratives 

✓ Search for a document electronically, no more misplaced documents or files 

✓ Immediate access to all files in a case 

✓ Detailed document markup and redaction 

✓ Pinpoint annotations case-wide 

✓ Effective case preparation and review 

✓ Efficient production preparation and export 
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New in Primafact 6 

Primafact 6 includes a number of new features, as well as enhancements to features available 

in previous versions.  These include: 

More Powerful 
Templates 
 

• Configure your Cases more efficiently than ever with more 
feature-rich Case Templates.  Case Templates now pack the coding 
standards and preferred views designed for your Case type.  

• Open Cases with views & coding already built-in, or easily update 
existing cases to match new Coding standards and report-friendly 
views.  
 

Primafact Inbox • This is a special user-level folder designed to facilitate document 
intake and review, with search, filter and messaging capability via 
the new Discussions feature. 

 

Review Workflows • New review workflow tools enable review tracking to more 
efficiently manage and monitor document review and associated 
activities.  

• Early Case Assignment enables documents to be associated with 
their assigned Case prior to filing. 

 

Document Discussions • This new feature allows messages to be exchanged within user 
Inboxes, with real-time notification. 

 

Binder Enhancements • Visual coding enhancements, search and filter tools directly within 
the binder, and enhanced previews make identifying materials in 
your binder more efficient than ever. 

 

Document Preview 
Enhancements 

• More information available on the Document Preview, with new 
Tabs for convenient annotation review and document discussion 
within Binders and Inboxes. 

 

Easily build 
Chronologies, Outlines 
and Reports 

• Instantly assemble chronologies and outlines from Primafact into 
Word and Excel 

• Link back directly to Primafact source content  

• Export URL link to Word memos 
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Annotation 
Enhancements 

• Chronology support with Event Date + Time tracking 

• 12 more annotation colours + custom labels for uniform coding 

• Dedicated favorability coding 

• Dedicated Text Excerpt field 

• Annotation Repeats, Templates & automation 

• Batch updating capability 

• Better annotation view and search on documents, previews and 
lists 

 

List View Enhancements • Control default views, create and access multiple alternate views 
that can be displayed in a single click 

• Pop-Out List feature enables list views to be displayed alongside 
other Primafact windows 

  

Copy Documents to 
Browsers 

• Drag & Drop documents to Browsers and other locations outside 
Primafact  more efficiently 

 

E-Briefs • Assemble electronic briefs, including CaseLines filings, efficiently 
with highlighting, hyperlinks, Document Title Aliases, and PDF 
Publish tools. 
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Getting Around Primafact 
 

Cases 

Primafact supports documents management by “Case”, which is visually identified as a black 

folder icon.  Supported with standardized but customizable binders/folders a Case includes 

coding and review features that make it easy to manage documents and associated markup for 

efficient ream review as Cases progress. 

 

Case Navigation Ribbon 

This blue ribbon, found at the bottom of the Case Binder and Case List Views, provides access to 

key Case views, along with Binder Page Numbering and Case Customization options accessed 

via the Gear menu. 

  

 

Accessing the Case Navigation Ribbon 
The Case Navigation Ribbon is only available on folders set up as Cases (identified as Black Folders 

in Primafact) – if your matters are set up in a regular yellow folder, you will not be able to access 

Case features, including the Case Navigation Ribbon. 

To access the Case Navigation Ribbon, click on any Case Binder.  You will see the blue Case 

Navigation Ribbon at the bottom of the binder view.  This ribbon is also visible using the 

Summary, Documents and Annotations screens.  The Case Navigation Ribbon is not available 

when viewing Case Content in a folder list view.  

 

Binder View 

The Binder is a unit for grouping documents in Primafact Cases.  The Binder View allows 

documents to be positioned in a discretionary order, as determined by members of the team. 
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Clicking on a Binder displays the “Binder View” for that Binder.  The Binder View also includes 

the blue binder navigation ribbon at the bottom of the screen, which allows users to access other 

Views, including the Case Summary screen, Annotation List, and Documents Views.  These views 

can only be accessed from within the Binder View.  

The order of documents displayed in the Binder View is common to all users – this means that if 

a document is moved by one user, it is seen in that same binder location by all users.  However, 

the Binder can be customized (numbering preferences, icon display preferences) at the user level, 

with selections not impacting other users. 

 

Binder Tabs and Sections 
Binders are subdivided into Tabs and sections for more detailed document organization and 

easier navigation.  The Tab is the highest level of binder organization, and each Tab can be 

divided into sections and subsections.   

 

 

Binder Collapse/Expand 
 

You can collapse binder tabs and sections to more easily navigate binders. Collapsing and 

Expanding Applies Only to You:  Unlike binder sorting, which impacts all users, collapsing and 

expanding tabs and sections only affects your view of the binder. 

 

A collapsed Tab/Section is indicated by 

this symbol (in the red circles) 

 

An expanded Tab/Section is indicated by 

this symbol (in the blue circles) 

 

 

1. Open a binder.  
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2. Click on the Collapse/Expand toolbar 
icon and select “Collapse All” or 
“Collapse” just the tab/section you have 
highlighted. 

 
 

3. Click on the Collapse/Expand toolbar icon and select “Expand All” or just the tab you 
have highlighted. 

 

You can also expand and collapse by: 
 

• Right-clicking anywhere in the binder and 
select Collapse All from the context menu. 

 

 
  

• Left-clicking on the expand/collapse 
triangle beside a tab/section: 

 
 
 

• Double-clicking on an collapsed tab/section heading will expand it. 
 

• Double-clicking on an expanded tab/section heading will collapse it. 

 

Document Preview 
The document preview makes it easier to identify documents in binders and on lists, by displaying 

the selected document on a single screen. 
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To display the document preview pane, click the    button at the far-right of the filter row 

near the top of any Binder or List View. 

To preview a document, simply click on any document title in your binder index to display the 

first page of the document. 

To close the document preview pane, click the    button to the right of the quick search panel 

above the binder index. 

 

Opening a Document from the Preview Pane 

You can read and do most review tasks using the Preview Pane, but in some cases users need to 

review an open document.  

To open a document from the Preview Pane, right-click on the preview pane and select Open 

Document in Tab.  Alternatively, you may click the document icon on the ribbon located at the 

bottom left of the preview pane.  You can also double-click on the document name in the binder. 

You can open the document in a new window (Detachable Document Window) by clicking on the 

New Window button in the lower left corner of the preview pane, if you prefer. 

 

Detachable Document Windows 

Viewing a document in its own window (detachable document window) makes it easier to view 

and work on more than one document simultaneously in Primafact. All features available for a 

document opened in its own tab are available in this new window. 

You can open the document in a new window by clicking on the New Window button in the lower 

left corner of the preview pane.  If viewing a document in a Tab, you can switch to a detachable 

window by clicking on the new window button at the top-right of the Primafact Toolbar.  

 Open from Primafact Document opened in Tab:    

 

 

Open from Preview Pane: 
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To restore the document to the main Primafact window, click the “Restore Window” button in 

the top right of the toolbar  

  

 

This will return the document to a tab in the main Primafact window. 

 

Case Navigation Ribbon 

The new case navigation ribbon at the bottom of the Binder View of any Case Binder  gives quick 

access to the Case Summary Document List, and Annotations List. 

 

The gear icon at the far right of the case navigation ribbon allows you to manage Case 

Issues, Bates IDs and AutoCompletes. 

 

Document List View  

In addition to viewing your document sets in the familiar binder index format, the Document List 

view gives you additional ways to sort and view document sets.  

The Document List view displays documents in listed orders that can be changed on-demand, by 

filtering the document selection, or ordering documents by selected fields chosen by the user, or 

by using Saved Views. Documents may be displayed by Binder or by the entire Case. 



 

©2022-2024  Sandcat Software Inc.  Working With Primafact 6     20 

 

Accessing the List View 
You can access the Document List view by selecting the Documents option on the bottom blue 

navigation ribbon. 

 

 

List View Features 
The List view displays documents in listed orders that can be changed on-demand, by simply 

filtering the document selection, or ordering documents by selected fields chosen by the user.  

Documents may be displayed by Binder or by the entire Case. 

 

Filtering the List View 
Applying filters to the List View helps you quickly locate specific documents.  Using the Quick 

Filter identifies only those documents containing the filtered term in any of the displayed fields 

(that are visible on your screen.  For example, typing a doctor’s name into the Quick Filter will 

limit the displayed documents to that doctor’s records, allowing you to quickly identify the 

document you are looking for. 

  

You’ll see the number of documents meeting the filter criteria identified in the lower-right corner 

of the list pane. 

To sort your list by different criteria, simply select the chosen header item on the top of the list 

to sort in ascending or descending order. 

 

Document Preview in List View 
As with the Analysis View, the List view offers the option of a Preview Pane to view any selected 

document, or the Profile Fields of any selected Document.  

To display the preview pane, select the chevron icon to the right of the filter bar.  

Your selected document will be displayed at the right of the screen.   
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Profile Preview 
To view the document’s Profile Fields, select the Profile tab in the Preview window.  The 

Discussion tab will display comments associated with the document. 

 

Adjusting List Views 
Primafact has list view options for  

• Folders displayed on the Explorer tab (includes clicking on a Tab, Section or Subsection in 

any Binder)  

• Case Documents 

• Case Annotations 

• Inboxes 

 

Exporting Document Lists 
To Export Lists see Exporting Annotation Lists & Reports. 

 

Favorites 

Favorites allow you to identify documents that you refer to frequently, for ease of access.  You 

can filter to favorites by clicking the  icon from any Binder or List View. 

 

Creating Favorites 
To apply the Favorite tag to a document: 

 Using the Preview or Profile Tab, click the greyed-out  icon to apply the Favorites tag. 

 

Removing Favorites 
To remove a Favorite tag: 

 Using the Preview or Profile Tab, click the  icon to remove the Favorites tag. 
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Setting your Personal Viewing Preferences 
About Viewing Preferences  

You can customize a number of personal viewing preferences for Primafact, which do not impact 

other viewers.  Customizable preferences include overall Preferences, Binder View settings, and 

List View settings for Primafact Inboxes and other Primafact Lists. 

 

Personal System Preferences  

To set your personal Primafact preferences: 

 On the Explorer Tab, go to the main Toolbar menu 

 Select Tools → Preferences 

 Select your desired options 

 Click OK when complete 

These preferences affect your viewing only.  Other users are unaffected by your selected 

preferences. 

 

Customizing your Binder View 

You can customize elements of your binder view, including the color of tabs and sections, 

displayed icons, as well as your numbering preferences. 

Binder Customizations affect your view only – other users are unaffected by changes you make 

to numbering style (e.g. A B C vs. 1.2.3. numbering).  (We do recommend that team members 

adopt a numbering standard for all users).   

Note that the order in which documents are displayed in Binder view is universal to all users.  

To Customize your Binder View: 

 In the Binder View, on the top tool bar select View 

 Select  Customize Binder View 

 



 

©2022-2024  Sandcat Software Inc.  Working With Primafact 6     23 

 

 

 Once your customizations have been selected, click OK. 

 

Adjusting Markup Display on a Document in 

Primafact 

You can set visibility of document markups on an open document in Primafact – this can be 

helpful if a heavily marked-up document is distracting.  

To adjust markup display settings: 

1. Click the Show dropdown on the open document toolbar: 

 

 

2. Click the markup items you wish to hide or display.   

Hidden markup will be hidden on all open Primafact documents (open on a Tab or separate 

Window) until you change Show/Hide settings.  

NOTE:   Markup is not hidden in document preview.  
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Search Tools 
How Text Searches work 

Primafact allows you to search scanned documents by converting the document content into 
searchable text using Optical Character Recognition (OCR) and mapping the results to the 
scanned page image. Handwriting is not converted to searchable text. Primafact supports full-
text searching of scanned, printed to Primafact and imported documents as well as linked Word 
and Excel files.   
 

Locating document content 

You can locate your document content a number of different ways in Primafact: 

✓ Binder Search & Filter  

✓ List View Search & Filter (Inboxes and Document Lists) 

✓ Quick Search (less powerful alternative to Binder Search & Filter) 

✓ Searching within a document 

✓ Using the Search Tab 

✓ Find Folder 

 

Find Folders 
 
The Find Folder button allows you to navigate quickly to a specific folder, binder, tab or 
section/subsection. For example, instead of scrolling through hundreds of matter names in a 
Clients folder, you can use the client name or matter number to go directly to the folder. 
 

1. Click on the Find Folder button at 

the top of the Explorer window. 
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2. Type all or part of a folder, 

binder, tab or section 

name and press Find, or 

click Enter on your 

keyboard. The first match 

will appear. 

 

 

3. Click       Next or        Previous to move to the next or previous match. 

4. If you are looking for a misplaced folder, you should make sure the Search for folders and 

binders in the trash checkbox is checked prior to executing the search. If this is checked, 

matching items from the trash will be shown. 

 
 

Quick Search/Quick Filter 
This is an alternate search option for the Binder view, for users who prefer Binder search 

options available Primafact 5 and earlier versions of Primafact.  Default Binder search settings 

are more robust and discussed in Binder Search and Filter. 

 

Quick Search Allows you to find document titles in Binder view (Does not search document 

text, just the titles) 

 

1. The Quick Search (highlights) field at the top of the binder view allows you to quickly 

jump to documents containing specific text in the title. 

2. In the Quick Search field, type part of the title for a document, tab or section. Press the 

Enter key or the  button to commence the search. 

3. Click       the  or       button to move to the next or previous match. 

 

In-Document Searching 
Searching within a document allows you to locate specific words or phrases within a selected 
single document (within an open document or using the Preview Pane). 
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Search within a document using the Preview Pane: 
 

1. Enter your search query in the Search Text box. Note: this search is very literal, and 

can find only one word or phrase at a time. Searching within a document does not 

accommodate quotation marks or wildcards.  

 

 

2. Click the binocular icon  or press Enter on your keyboard to identify matches. 

3. Click       the  or       button to move to the next or previous page containing a match. 

 

Search within an open document (tab or separate window): 
 

1. Click on the binocular icon    in the toolbar. 

 
  

2. Enter a word or phrase in the text-entry area. 

Note: this search is very literal, and can find only 

one word or phrase at a time. Searching within a 

document does not accommodate quotation 

marks or wildcards.  

 

3. Press Enter on your keyboard 

4. The current match will be highlighted in Orange 

and other matches will be highlighted in bright 

green.  Bright green arrows indicate more 

matches on other pages on the toolbar indicate 

matches on other pages of the document.  

 

 
 

Using the Search Tab 

Global Searching & Selected Folders 

Why Use the Search Tab 

The search tab is a flexible tool that allows you to search Globally across Primafact, as well as 

drilling down into selected folders, tabs and sections.   
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The search tab is the only search tool in Primafact that allows you to search Globally across 

Cases, and to find content in the Trash and Archives.   The search tab is the only tool that 

permits detailed Boolean searching of Profile Fields across the Primafact database. 

 

By Default, the search tab scope is set to search the currently selected folder (selected in the 
Explorer Pane).  You can search the whole database by selecting “All” folders.  
 

Basic searching 

Once you have set the scope for your search (All vs. Current etc.) 

 

1. Click on the Search tab or the 
Search shortcut to open the 
search window. 
 

 
  

2. All search is the default.  This 
works like a Google search – 
Primafact will look for 
documents containing each of 
the words or phrases you type 
into the search bar. 

 

 

3. Enter the word(s) or phrase you 
wish to locate in the search 
field (search terms are not case 
sensitive). 

 

 

 

 

 

4. Click the Search button or press 
Enter  

 

 
 
TIP: Searching for probable cause (without quotations) will find all documents which contain 
both the words “probable” and “cause”; 
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Searching for “probable cause” (within quotation marks) will find all documents containing the 
exact phrase. 
 

Working with Search Results on the Search Tab 

 
The search results are divided into two parts. The top section displays all the documents which 
were found; the bottom section shows the matches for the highlighted document. 
 
By default, documents are sorted by the number of hits – greatest to least. You can change the 
sort by clicking on one of the other column headings. For example, clicking on Added will sort the 
documents from oldest to newest. Clicking on page number will show search results by largest 
documents. 
 
Documents appear in the 

top frame. Matches 

(“hits”) within the 

highlighted document 

appear in the bottom 

frame. 

 

Coloured arrows indicate 

a page grouping - in this 

example, there are four 

hits on page 4. 

 
 
1. Click on a document 

name in top pane to 
reveal hits by context in 
lower pane. 
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2. To view a hit in context, 
use your mouse to place 
the pointer over the hit 
you wish to review. A 
yellow dialog will pop up 
with that hit in its 
immediate context. 

 
  

3. Double-click on the 
selected hit to open the 
document at the page 
where the match occurs. 
Text matching selected 
search terms is 
highlighted in green. 

 
 
Use the Green arrows at the top of the toolbar to advance to the next or previous page containing 
a search “hit.” 
 
NOTE: In Normal view, you can use the Browse area to display a list of all documents picked up 
in your search.  Clicking any of the documents will open that document in your Tab – which can 
be an easier way to review your search results than by going back and forth to the search tab. 
 

Advanced search options 
 

Using Wild 
Cards 

An asterisk (*) can be used as a “wild card” to replace any number of 
characters sharing a common root. This is useful when searching for a word 
that may come in a number of forms, or may have a number of spellings. 

 

NOTE: Your search string is limited to 15 characters plus a wildcard. 
 

Wildcard examples: 
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• misrepresent* will return words beginning with “misrepresent”, such as 
misrepresentation, misrepresentative, etc. Searching for “misrep” 
without the wildcard (*) will not find occurrences of the word 
“misrepresent”. 

• *cause will return words ending with “cause”, such as cause and 
because. 

• s*s will return words starting and ending with the letter “s”, such as 
statistics, stats, states, etc. 

 
You cannot use the asterisk twice in a word.  
 

A question mark (?) may be used as a “wild card” to replace a single 
character in a word. It will replace only one letter at a time, in the exact 
location within the word. You may use more than one question mark within 
the same query. 

 

For example: 

 

• L?W will find words like law and low, but not words like lockjaw. 

• SP??E will find words like spine and space, but not specialize [sic].  
  

 

Types of content you can search: 

 
If you check the Show 
Additional Options box, 
you will have additional 
options available that 
will allow you to search 
for specific content: 

 
 
 

Check this: To Do this: 

  

Text Find all documents containing the search term(s) anywhere within 

the document text. 

  

Titles Find the search term(s) in document titles. 

  

Annotations Find the search term(s) in the Annotations. 
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Profile Fields 
 
 
Using the Profiles 
Tab (on the 
Search Tab) 

Find the search term(s) in the document metadata (the profile fields 
shown at the right when you open a document): 
 
1. Select the category you are using when viewing documents (or 

another one entirely) by clicking on the dropdown button and 
selecting the appropriate category: 

 
 
2. Click on the dropdown list beside the category field you wish to 

search and select the criteria. 

 
 
3. Enter in the search term 

 
 
 
4. Click on the Search button 
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Text Search Operators (Simplified Boolean Search Commands) 

 
The scope of your searches is also governed by the Boolean connectors you select to create the 
parameters of your search. 
 

ALL & AND In Primafact, the ALL search is an AND search. 

 

AND restricts the results to documents that contain both phrases. ALL restricts 

the results to documents that contain ALL of the words or phrases entered (in 

an ALL search, double quotes are used to define a single phrase). 

 

Documents containing only some of the selected words or phrases will not be 

identified by these searches. 

  

OR Broader than an AND or ALL search; results include documents containing any 

of the phrases entered. 

  

AND NOT Restricts results to documents containing the phrase selected EXCLUDING 

documents containing a particular word or phrase. 

  

NEAR This is also known as proximity searching. Finds documents containing terms 
located within designated number of words from one another. 
 
For example: If you search for “back” within 8 words of “pain”, then it would be 
found in a document containing “she complained of back pain” or “patient was 
exhibiting lower back and hip pain’. 
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Working with the Binder View 
 

Binder Search and Filter 

You can perform full-text document searches directly from your Primafact Binders, to locate 

specific information located within the Binder. You can combine filters with searches for very 

targeted document identification within your binders. 

 

Search Bar 
The search bar is located at the top of the Binder toolbar.   

 

By default, Primafact 6 is set to perform full-text searches, including document titles, page text, 

annotations and profile fields.  To perform a search, click on the search area and type your 

search query.  Click the Enter key to perform your search.  To adjust search settings, see 

Changing the Search Filter Options, below. 

If your search bar is set to perform Full-Text searches, you can use wildcards (* character) to 

replace characters in your search. 

 

Changing the Search Filter Options 
The Binder search bar can be set to perform a Quick Search, which searches document titles,  

or Full-Text Search, which can include content in Titles, Page Text, Annotations and Profile 

Fields, depending on your selected settings.  

1. To adjust your settings, click the filter dropdown to the right of the search bar: 

  

2. Click Search Options. 
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The Binder Text Filter Options dialog will open:

 

3. Select the Quick Filter button to perform Quick Searches.  Select the Full Text Search 

Button to search for text content within your documents. 

4. Selecting or de-selecting the Titles, Page Text, Annotations, and Profile Fields checkboxes 

will adjust the scope of your Full-Text Search. 

5. Click OK to preserve your selection. 

 

Using Filters 
You can use filters on their own, or combine with text filtering for focused document 

identification.  You can also apply more than one filter at a time for more refined results.   

Filters are located on the binder toolbar to the right of the binder search bar.   

 

 

Available filters for the Binder view are: 

 Key Document 

 Team Flags (Dropdown allows you to select multiple flag colors) 
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Annotation Colors (Dropdown allows you to select multiple annotation 
colors 

 Annotation Favorability (Choose Favorable, Adverse, or both using the 
dropdown) 

 Annotation Issue  

 
 

Document Date (Allows you to specify document date or date range) 

Unread Documents 
 

 

Reviewing Filters 
1. To review which filters have been applied, click the yellow Filters button: 

 

2. The Current Binder Filters window will open: 

 

3. Click OK or Cancel to close. You can also selectively clear filters using this window.  

 

Clearing Filters 
4. To clear an individual filter, click on the selected item to de-select.  For filter options with 

a dropdown, click the dropdown and select Clear Filter. 

You can also click the X on the Clear Filter button to clear all applied filters. 
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Selectively Clear Filters 

1. To selectively clear filters, click on the yellow Filters button.  The Current Binder Filters 

window will open.  

 

2. Select the filter you want to remove and click the red X button.   

3. Repeat as desired.   

4. When finished click OK. 

 

 

Document Preview 

The document preview makes it easier to identify documents in binders and on lists, by displaying 

the selected document on a single screen. 

If the preview pane is not displayed click the    button at the far-right of the filter row near 

the top of any Binder to display the preview.   

 

Clicking the    button to the right of the quick search panel above the binder index will hide 

the document. 
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Document Preview Tabs 
The Preview area has several tabs that display additional information about  

the previewed document.  

• Preview Tab – Displays selected document 

• Profile Tab – Displays associated document 

profile information 

• Discussion – Displays document discussion 

history 

• Annotation Tab – Displays document 

information on a searchable, filterable list 

• Highlights Tab – Shows highlighted text & 

connects to associated pages 

• Links Tab – Shows hyperlinks added to a 

document, notes and link address 

• Information – shows additional document-

level information, including document 

locations in Primafact, OCR status, review 

status and technical information 

Each of the Preview, Profile, Annotation and Links 

Tabs display the document Title, Key Document 

coding, Reviewer and Team Flag information. You can name/rename the document, apply Key 

Document coding, apply Review status and apply Team Flags using any of these three tabs. 

 

Organizing Binders 

Primafact binders are designed to permit flexible positioning of Tabs, Sections and Documents.  

Unless Auto-Sorting has been applied, simply click and drag to move documents to their desired 

position.  

 

Sorting Binders 

Set Binders to Auto-Sort 

One of Primafact’s most powerful features is that it lets you organize your documents very 

flexibly, by positioning documents exactly where you want them.  Note Binder order is Global – 

all users will see all documents displayed in the same order when they are in Binder View. 

However, if you prefer, you can set binders to automatically sort incoming documents by one of 

the following three categories: 
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✓ Document Date (provided the document has been assigned a date) 

✓ Document Title 

✓ Date Document was added to Primafact 

This can be quite helpful for document types such as correspondence, which are typically 

organized in chronological order, by date sent/received.  However, auto-sorting may not be 

appropriate for other file types, which might be organized by issue, for example.   

Auto-sorting works only at the binder level (you cannot auto-sort individual tabs or sections).  

Accordingly, if you have some types of documents that are auto-sorted (such as correspondence), 

we often recommend setting up a separate binder.  This can make it much quicker to file 

documents sent to those binders. 

You cannot manually reposition documents in any binder set to Auto-Sort, unless positioning 

documents with the same Sort value (e.g. same Document Date). If you are not happy with auto-

sorting the binder, you can turn Auto-Sorting off at any time. 

 

Discretionary Document Sorting 

You can sort documents by the above categories at the Binder, Tab, and deeper levels at any time 

by manually initiating a sort.   

Sorting re-orders your documents within each tab/section/subsection (documents will not move 

to different tab or section locations during a sort).  Individual documents can be repositioned 

manually after the sort.  

Note: You cannot “UNDO” a sort.  (This means you can’t revert your documents to their pre-

sort order using the UNDO button; you can re-sort or manually re-order documents after 

applying a sort.) 

 

Sorting a binder: 

You can sort using any of the three options in ascending or descending order. 
 

 Select the Tab or section you wish to sort. (This is not necessary if you are sorting the 

entire binder.) 

 Click on the Sort icon in the menu bar. (Alternatively, you can sort by right-clicking in the 

Binder and selecting Sort followed by the desired option.) 

 Select the level (Binder/Tab/Section) you wish to sort. 
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 In the sort window, choose the sort category, in 

ascending or descending order. 

 
If sorting by date, undated documents will be 

displayed at the top (if “Sort Ascending” is 

selected), otherwise, they will appear at the 

bottom (if “Sort Descending” is selected). 

 

 

 If desired, you can select the Automatically sort newly arriving documents checkbox to 

have inbound documents automatically land in the sort order as they arrive in the binder 

(NOTE: this option is available to entire binders only, and not to individual tabs or 

sections). 
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Managing Documents 

 

Importing New Documents 

Files can be imported to Primafact via Drag & Drop, or by right-clicking on any Binder, Tab, Section 

or Folder and selecting New > Import and navigating to the source document location. 

You can Drag & Drop emails from Outlook, and can import attachments directly from emails. 

Once Imported, a document is considered a “native” Primafact document, which is stored in the 

Primafact database and supports document coding, including annotations, Team Flags, and 

Profile field coding. 

Primafact will import the following file types as “native” Primafact documents:  

• Word 

• PDF 

• msg  

• JPG 

• TIF 

• BMP 

If your firm scans using high-end multifunction copiers attached directly to the network, this 

typically will “push” scanned documents to a server hard drive location.  These files can be 

imported to Primafact using the import function. The import function also allows you to add 

documents provided on CD or DVD media from third parties.  

Drag & Drop Import 
 

 Select the desired tab or section destination in Primafact. 

 Drag & Drop from the source location to the desired Primafact location 

Import Documents Menu 

 Select the desired tab or section destination in Primafact. 

 Right-click and select New → Import) 

 (Alternatively, click on Tools -> Import Documents)  

You will be presented with the Import Documents window below.  It is divided into two 

parts: the left shows the folders in the file system; the right shows the documents in the 

currently highlighted folder: 
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 Select the files you want to import by checking each selected document (or by right 

clicking and choosing Select All). 

 
 The bottom left of the window shows the location in Primafact where the checked 

documents will be imported. 

 
 This usually defaults to Scanner Inbox.  A different Primafact folder can be specified by 

clicking the Destination Folder button.  Doing so will display the Select Primafact Folder 

window, where you can navigate to the desired Primafact location. 

 

 The selected documents can be moved or copied into Primafact.  

a. When COPY is chosen, it will leave the selected documents on the network folder 

location, these “source” documents will NOT be deleted. 

b. However, when you select MOVE, the files in the file system folder will be 

removed after they have been imported to Primafact.  This is to help users with 

workflow, the assumption being that PDF and Image files represent scanned 

documents which only exist for the purpose of being imported into Primafact, and 

once imported they are no longer needed. 

If you wish to import native documents into Primafact without removing them from the file 

system, make sure that Copy Documents to Primafact (and keep originals) is selected. 

 



 

©2022-2024  Sandcat Software Inc.  Working With Primafact 6     42 

Importing Email (Outlook Integration) 
You can import email and/or supported attachments from Outlook to Primafact by Dragging and 

Dropping.   

The Primafact Plug-In is needed to access the Outlook Integration features, including how to 

easily control how Outlook email and attachments are imported.  (You can select what content 

to import, and whether email and attachments are imported independently, or merged together 

as a single email.)  

 

Email Autonaming 

Emails imported to Primafact are autonamed, according to a pre-determined format. 

Attachments imported independently retain the filename of the original attachment. 

Supported Attachments 

Primafact will import some attachments directly to Primafact.  Supported attachments are: 

• Word documents 

• PDFs 

• WordPerfect Documents 

• Attached Emails (but not their attachments) 

Unsupported Attachments 

Certain attachments will not be imported to Primafact.  You can bring them in by other 

methods, such as saving to the network and linking (e.g. video files or Excel document), saving 

as a PDF and importing (e.g. Excel document that you want to crystallize), or Printing to 

Primafact.  

Unsupported attachments include: 

• Excel documents 

• Audio/video files such as MP4s  

• Attachments to attached emails (open the attachment and import independently) 

Send to Primafact from Outlook  

This import option allows you to send your email (with or without attachments) directly to 

someone’s Inbox.  It is a great option when you are delegating your document intake to an 

assistant.  
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Send to Primafact using the right-click menu in Outlook : 

 Right-click on the desired email(s) in Outlook.   

 Select Send to Primafact from the pop-up menu, then choose the recipient.  

 

 The email will arrive in the recipient’s Inbox. 

 

Drag and Drop from Outlook 

You can also import an email by dragging it directly from Outlook into any Primafact binder 

(Binder View recommended).   

 

Print to Primafact 
 
Print to Primafact saves you from printing and scanning materials that need to be in Primafact.  

Print to Primafact uses a special print driver that creates a file that you can save in Primafact.   

Typically this feature is used with non-TWAIN scanners cannot scan directly to Primafact – 

selecting the scan to Print option, to direct your document to Primafact.   

 Documents can be printed directly into Primafact from any Windows application that supports 

printing (e.g. – Word, WordPerfect, Outlook, or any page on your web browser).   
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1. From your document (or email, browser window, scanner application etc.: 
 

2. Choose Print within Microsoft Word as shown here: 
 

On the On the Print Dialog, 
choose Primafact from the 
list of Printers, and in this 
case, leave all other printing 
options at their default. 
 
Click OK.   

 

 

3. Primafact will open a window allowing you to choose a destination within Primafact where 
the document will be saved as shown on the image below - select the destination folder, and 
click OK: 

 

 

 
If your document is not already named, you can apply a name using the “Document Title” area 
shown above.  
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4. Click OK to save the document in Primafact. Click on “Open last Batch of Documents” if you 

want to see the documents in Primafact. 
 

 

Importing a Primafact CD (Primafact Publish Import) 
You can import Primafact CDs from other firms into your firm’s Primafact and maintain the 
complete structure as seen on the disc: 
 

 Set up an IMPORTS folder if one has not already been created.  You will be importing your 

documents to this Folder (or another non-Case folder), then moving them to your desired 

Primafact Case location. 

 Insert the CD/DVD you received from another law firm using Primafact.  If you received 

the file as a link, you will need to unzip the file to import. 

 From the main Primafact menu, select Tools > Import Published Documents 

 Select the desired folder.  (If you wish to preview contents, click a folder on the left to 

view its documents on the right. Note that for binders, you have to click each individual 

tab and section - the 

contents of tabs and 

sections are not shown 

when the binder icon is 

highlighted).  

 Highlight a folder to see its 

content.  Although they 

will be imported, linked 

documents are not shown, 

only scanned and imported 

documents are shown. 

 Click the Destination 

Folder button at bottom 

left to select the Primafact 

folder where the documents should be copied. 

 Make sure any folders you want to import are checked. When you check a folder, all the 

subfolders are automatically checked as well. 

 Click Import to start the process. 

 When complete, a message is displayed indicating the import was successful. 
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Naming New Documents 

Documents in Primafact should be named in a way that makes content clear to a user, and reflects 

naming that would be appropriate in a Productions Index.  Document names in Primafact may 

differ from the names of documents actually filed with the Courts. You are responsible for 

ensuring that documents are named in accordance with the practice directions of the applicable 

courts where applicable.   

Documents brought into Primafact will retain the name that they were assigned at the time of 
Scanning, or the name that they acquired in Windows (Word, Outlook emails, file names on CD 
etc.)  You can rename these documents at any time.  
 
Scanning to Primafact – Auto Naming 

Scanned documents are automatically numbered in the sequence that they have been scanned, 
i.e. “New 00000012”. It is helpful to have a document preview displayed as you rename it as 
this allows you to review the document’s contents as you assign a new name. To rename: 

 

1. Review the document in the preview pane.  Locate the page with appropriate name/date 
information, if necessary. 

2. Right-click the document, and select Rename and type in the name of your document, or 
rename in the Document Title area of the Preview tab. 
 

Applying a Document Date 
The document date should be included in the document title where possible (adding a date to 

the Document Date Profile Field enables your document to be sorted and filtered by Date. 

You may want to consider aligning the format with Court guidelines.  For Primafact to recognize 

a document date from your document title, ensure that your date format matches Primafact’s 

recognized date formats below.  

If you include a document date using a recognized date format in your document name, 

Primafact will automatically populate the Document Date field with the date specified in the 

document name. 

Recognized Primafact date formats 

Primafact will recognize date formats included in a document title in addition to the examples 

above.   Details on how Primafact’s date triggers work and accepted date formats are listed 

below.  

We recommend adopting team-standardized date formatting for document titles.  
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Except where the document date appears at the beginning of the document title (where 

document date is automatically recognized), the document date must be preceded by one of 

the following to trigger date recognition:  

✓ dated 

✓ from 

✓ on 

✓ to 

✓ hyphen preceded and followed by a space ("[name] - [date]") 

* The year must be indicated by 4 digits.       

              

What if more than one date appears in a document name?  

If more than one date keywords is included in a document title and followed by a date, the first 

date following a recognized date trigger is taken.        

           

 Hospital Records from St. Michael's from January 1, 2019 to May 30, 2021  

...the document date is January 1, 2019       

    

Example 2          

 Hospital Records from St. Michael's January 1, 2019 to May 30, 2021   

 ...the document date is May 30, 2021        

 Example 3          

 January 1 2019 Hospital Records from St. Michael's January 1, 2019 to May 30, 2021  

 ...the document date is May 30, 2021       

    

Valid Date Formatting Options:         

 01-JUN-2021 

June 1, 2021       

JUN 1, 2021       

1 Jun 2021       

Tuesday, June 1, 2021       

Tuesday June 1 2021  

2021 Jun 1        

 06/01/2021*  

e.g

. 
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06.01.2021* 

06-01-2021*        

2021 06 01*        

2021.06.01      

2021-06-01    

 

Digits may be separated by any of the following characters: / \ - , ( ) ? ? | { } [ ] ~ . ` space 

  

* [note in some cases your System may override date formats so that dates above are interpreted as January 6, 

2021.  Test to confirm date defaults on your system.]       
   

 

Document Copy & Duplication 

At times you will want multiple copies of the same document in Primafact.  Copy allows you to 

position the same document, inclusive of coding, in multiple Primafact locations, for ease of 

access.   Duplicate creates a stand-alone clone of your document, inclusive of most coding.  Any 

subsequent changes made to the original document do not impact the duplicate.  Any 

subsequent changes made to the duplicate do not impact the original.  

You can also copy or duplicate entire Tabs, Sections and Binders.  

Duplication 
A few things to keep in mind when duplicating documents: 

✓ When duplicating a document to the same case, Bates IDs are retained 

✓ When duplicating a document outside the case, Bates IDs are removed 

✓ Document Discussions are not included 

✓ When duplicating a Case folder, all information, including Bates IDs, is duplicated.  

 

To duplicate a document: 

 Right-click on the selected document.  

 Select Duplicate. 

 Select the target folder, binder or Case. 

 Right-click and select Paste.  
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Making a Copy of a Document 
Essentially copying a document creates a “shortcut”, which allows you to access the same 
Primafact document from multiple locations.  For example, you may create a separate binder 
with select materials for a motion, while keeping your principal document set intact. 
You can only copy a document to other locations in the same Case, or to any non-Case folder, 

such as an Inbox.  You cannot copy a document to another Case. 

Any changes you make to any “copy” impacts all “copies” in the database will be copied 

separately into the binder.     

 

Merging Documents 

 
Merging brings multiple documents together into a single document. 

Merging documents is useful where a document is too large to be fed through the scanner at one 

time, or where a document is assembled incrementally over the lifetime of a file.   

To Merge two documents into one: 

In the BINDER VIEW1 

 Left-click on the document that will comprise the first pages of your merged document.  

The resulting merged document will retain the name, location, profile field content and 

discussions on this document ONLY.  Name, location, profile information and discussions 

on documents merged into this document will be lost.   

 Press and hold the CTRL key and select the next document that you wish to merge into 

the first.   

 Right-click and select Merge 

 Your merged document will appear as the first-clicked document, along with any profile 

field content and discussions associated with that document.  Merged documents appear 

after the last page of the first-clicked document.   

 

 

NOTE: Primafact recommends limiting documents 1,500 pages. Longer documents can be split 

into multiple volumes. 

 

 
1 Note document merge order differs when merging documents in a list, rather than in Binder view. 
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Extracting Documents 

Extracting allows you to: 

• split a single document into multiple documents, OR 

• duplicate selected pages of a document into a separate document 

Extracting is useful when you batch scan multiple documents in at the same time, or when you 

find that a very large document should be broken up into smaller pieces, individually named. 

It can also be helpful to create freestanding documents, while keeping an original document 

intact, such as preserving a complete set of Clinical Notes, along with a separately managed 

Report that is also part of the Clinical Notes.  

 

To extract pages from a document: 

Open the document you want to Extract from. Choose Thumbnail view. 

 Right click and select “Extract Pages” from the context menu.   

 The extract dialog will open. 

 Rename the document as desired.  If you do not rename, the new document will be 

named “xx pages extracted from Document Title” (unless you named it in above option). 

 Choose a destination for the extracted document page(s).  (If no destination is selected 

the extracted document page(s) will be placed in the same directory as the source 

document. 

 Select Move or Copy: 

a. Select “Move” to remove selected pages from the original into a new document.   

The original will no longer include these pages.  This is a “CUT”. 

b. Select “Copy” to place copies of the pages in a new document.  The original 

document will remain intact.  Note the Copy will not include annotations, but will 

include redactions from the original document. 
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Document Intake and File Assembly 
Scan Settings 

When scanning documents into Primafact, we recommend the following settings: 
 

• Black and White 

• 300 PPI (this is the minimum setting, do not scan at 200ppi or lower) 

• To keep file sizes as small as possible, color should only be used for documents that need 
to be in Primafact in color – i.e. photographs 

I Want To… Doc  
Type 

Input  
Type 

What it Does How to Do It Who Uses It? When To Use 

Scan paper 
documents 
directly to 
Primafact  

(Dedicated 
Scanner) 

Paper Direct 
Scan 

Scans document 
directly into 
Primafact (no 
interim 
placement into 
Windows or 
Outlook) 

Select New > Scan 
and document 
destination. 

Requires 
Connection to a 
TWAIN Scanner. 
 

Typically used 
by firms with 
Centralized 
Scanning 
workflow  

Performed by 
Scanning Clerk 

Requires a TWAIN 
Scanner. 

Bring Paper 
documents 
into Primafact 
using a 
networked 
scanner 
 

Paper Scan  
+  

Import 

Moves/copies 
scanned 
documents into 
Primafact 

1. Scan your 
document to 
your email or to 
a Shared Folder 
on the Network 
(Windows 
Folder). 

 
2. Use the New > 

Import menu  
or 

Drag and Drop 

from Windows, 

Outlook, select 

applications. 

Firms without 
a TWAIN 
scanner 

Performed by 
Staff with 
filing 
responsibility 
(Legal 
Assistant, Law 
Clerk, or 
dedicated 
Scanning 
Clerk.) 

When using a networked 
scanner. 

Bring PDFs or 
other scanned 
documents 
into Primafact 

Electro
nic 

Docum
ents 

(PDFs & 
photos) 

Import Converts files in 
.PDF, .TIF, .JPG 
& .BMP to 
Primafact 
documents 

1. Use the New > 
Import menu  

or 
2. Drag and Drop 

from Windows, 
Outlook, select 
applications. 

Users with 
existing PDF or 
other 
supported file 
types  

For these file types: 

.PDF        .TIF 

.JPG        .BMP  

Bring an email 
or Word 

Emails 

Word 
Docs 

Drag 
& 

Drop 

Converts 
documents into 

Drag & Drop from 
Windows  

Creators of 
new 
documents – 

For internally-created 
“final” documents, or 
Outlook emails. 
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document 
into Primafact 

or 
Print 

to 
Prima
fact  

 

static Primafact 
documents 

OR 

Using File > Print 
from any printable 
application (e.g. 
Outlook, Word, 
Web Browsers) 

eliminates 
need to print 
and scan 

(Can be used for any 
document file-type.) 

Link regularly 
updated 
documents 
(e.g. running 
memo, 
Undertakings 
Chart) to 
Primafact  
 
 
  

AV 
files, 

Docum
ents 
you 

want to 
edit in 
Word, 
Excel 

 

Linke
d 

Docu
ment 

Creates 
shortcuts from 
Primafact to 
documents 
stored on your 
network 

Text in linked 
files can be 
searched in 
Primafact 

Documents 
remain editable 
(subject to 
security settings 
& permissions) 

1. Use the New > 
Import menu  

or 
2. Drag and Drop 

from Windows, 
Outlook, select 
applications. 

 
*Note: File must be 
located in a shared 
server location. File 
name & location do 
not automatically 
update if 
renamed/moved on 
server. 

Users who 
wish to access 
diverse file 
types from 
within 
Primafact 

1. For audio video file 
types - e.g. emergency 
call recordings, videos 
 

2. For routinely accessed 
editable documents  
(e.g. Undertakings 
Charts, Running File 
Memos) 
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Understanding Case Templates 

A template is the foundation of your files, providing the “skeleton” Case onto which your new 

client files will be built.  Each Case includes one or more binders organized with tabs & sections 

to sort documents by type.  Templates can also include Case-specific coding, including Annotation 

Color Labels, Annotation Issues, Team Flag Labels and List Views. 

Similar to precedents found in a law 

firm, Templates allow files to be 

quickly assembled to a consistent 

standard.  The new Case can be 

amended with additional Binders, 

tabs and sections as needed to 

reflect the unique needs of the file. 

Each binder will be organized with 

tabs (shown in red text in the image 

to the left) and sections (identified 

with green text in the image to the 

left). Tab and section colors are 

customizable at the user level. 
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Creating a New Case in Primafact 

1. In the Explorer view, right-click where you would like to create the folder and select New 

and then select Case. 

 

2. When adding a new Case to Primafact, you will now see a new Create New Case dialog: 

 

Now you can enter your New Case name before it’s created, and select the Template you 

want to use for your Case using the dropdown beside the Select a template field. 

By default, all Template settings, including coding settings and views, will be included in 

your new Case.   
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Optional: to selectively apply Template Settings click the Show More button and choose 

your settings. 

Click Create Case to save your new Case.   

Note: You can also copy the structure and settings of a selected Case, in addition to copying 

from Templates, by un-selecting the Case Templates Only checkbox.  This allows you to use any 

Primafact Case as the basis of your new Case.  

 

Add Date of Loss to your Case 
Adding the Date of Loss to your Case Summary makes it easy to filter Events by Pre-DOL and 

Post-DOL using Primafact filter tools.  Also, the date of loss is displayed on all Case Binders and 

Case Views, for convenient reference. 

To add the Date of Loss to your Case: 

5. Navigate to any Binder in your Case 

6. Select Summary on the blue case navigation ribbon. 

 

7. The Summary Screen will open. 

8. Click the Edit button to add the Date of Loss. 
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9. Enter the Date of Loss in the Date of Loss field 

 

 

10. Click Save to preserve your new setting. 

 

The Date of Loss will now appear at the top right of your Case views, and will be available for 

use in Date of Loss-related filters. 
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Updating Existing Cases  

Converting a Regular folder to a Case  
If you are creating a Case from an existing folder, you can convert the folder to a Case. 

 Right-click on a folder and select Convert to Case. 

 The icon for the folder will switch from manila-coloured to black  
to signify the change to a Case.   

 

NOTE: Cases cannot be nested within other Cases. 

 

Updating Existing Cases to Match Template Settings 
If you are updating to Primafact 6 with an existing caseload, it’s easy to update existing cases to 

match your Templated Coding Standards and Case Views.  You can even apply coding settings 

from another Case using this tool. 

 

Apply Settings from a Template to an Existing Case 

 

1. Start by opening a binder on the Case you want to update. 

2. Click the Geary on the far-right of your blue Case Navigation Ribbon. 

 

3. Click Setup Case From Template from the dropdown menu. 

4. The Setup Case Window will open. 

5. Choose the template you wish to copy. 

 

6. Click the Chevron beside any areas you wish to copy. 
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7. Select the Copy Case Template button for template options you wish to copy to your 

Case.  Select Keep Current to retain your Case’s current settings for that setting.  (By 

default that setting will make no changes to a selected setting unless you select Copy 

Case Template.) 

8. When you have completed your selections, click Update Case to update. 

9. To select specific areas to update, expand the Other Setup menu item using the blue 

chevron to expand.  
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Document-level Coding  
Team Flags 

Primafact 6 Team Flags allow you to tag documents with a labelled flag to easily identify and 

filter documents.  Team Flag labels are set by the team.  Team Flag Labels can be set up globally 

or by Case. (Applying Case label settings overrides the Global settings for that Case.) 

Thirteen (13) Team Flag colors are available in Primafact 6.  There is no limit to the number of 

Team Flags that can be applied to a document. 

Applying Team Flags 

Apply to a single document 

To apply a Team Flag to a document: 

1. Click the Team Flags dropdown button on the document Preview or Profile Tabs.   

 

2. Click the desired Team Flag to apply.  Repeat as needed. 

Apply Team Flag to Multiple Documents at One Time 

1. Select your desired documents in the Binder or List View 

2. Right-Click to display the pop-up menu: 

3. Select Team Flags 

4. Select desired flag.  Repeat as needed. 
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Removing Team Flags 
Follow the same steps outlined in Applying Team Flags, above.  Repeat as needed. 

Filtering by Team Flag 
You can filter by Team Flag in the Binder and List Views.  Team Flag filtering is not available on 

the Search Tab. 

1. Click the Team Flag dropdown and select your desired flag filter. 

 

 

Filtering by Multiple Flags 

To filter by more than one flag: 

1. Click the Team Flag dropdown and select your desired flag filter. 
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2. The Select Team Flags window will appear: 

 

3. Check the desired Flags. 

NOTE: The Team Flags Filter is an <OR> search among Team Flag Values.  In the above 

example, this means that the filter will identify any document with either the Liability Flag 

or KEY ADVERSE DOCUMENT FLAG (or both).   

Profile Fields  

Adding information to Profile fields makes it easier to record and retrieve document-level 

information as your case progresses.  You can use profile field data to filter documents. 
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See Profile Fields for details on customizing and managing Profile Fields. 

Batch Profile Updates 

Batch Updates allows you to update Profile fields on multiple documents at one time using the 

the Documents List and Folder List views.   

 

 

Complete a Batch Profile Update 
You have the option of batch updating profile fields of selected documents or all documents on 

the filtered document list at one time. 

1. To Complete a Batch Update, select the desired documents on your list, using the 
control (CTRL) key and your left-click button on your mouse. (If you plan to update 
all documents on the list, skip this step.) 

2. Select the drop-down arrow beside the Multiple Updates icon.  

3. Select the desired scope (update selected documents or all documents). 

 

4. Apply your desired values within the applicable profile field(s) – you may update 

several fields without leaving this window.  

 

 
 

5. Click the applicable update button (Update All, Update if Blank, Append, Clear, or 

Do not update). 

6. Select the Apply button to apply your changes.   
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7. Continue updating fields as desired. 

8. When you have finished your updates press OK. 

9. Your updated profile fields will be applied to the selected documents. 

NOTE: You may use Batch Profile Updates to replace entire profile field content, or to 

append information to existing content. 

YOU CANNOT “UNDO” A BATCH UPDATE – you would need to revise fields individually 

or by completing additional Batch Update operations. 

 

Undo 

 
The “undo” feature allows you to undo the following four types of operations: 
 

• Folder and Document Deletions (depends on security settings) 

• Folder and Document Cut and Paste’s 

• Folder and Document Copy and Paste’s 

• Reordering of Documents in a Binder 
 
You cannot undo anything else in Primafact. 
 
Primafact will remember Copies, Moves, Reorders and Deletes for up to 60 days.  
 
Primafact only shows you the operations which you performed - you cannot undo operations 
performed by other users. 
 

1. To access the Undo dialog, select 
Edit > Undo from the main menu 
while in the Explorer view. You can 
also press Ctrl+Z. 

 
The window lists all the actions 
which can be undone. As you hover 
the mouse over each one, details of 
the operation are shown. 

 
  

! 
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2. To “Undo” an operation, highlight it 
and click the Undo. You will be 
prompted to continue. Click Yes to 
proceed. Only one operation can be 
undone at a time. 

 
In this example, "Copy of PreTrial 
Binder" folder was deleted from 
"Doe, John Product Liability)" 4½ 
hours ago. By undoing the deletion, 
the folder is moved from the trash 
to "Doe, John Product Liability)". 

 

  

3. If you want more details shown for 
each operation, click the Show 
Details button at the bottom left of 
the dialog. A list of folders and 
documents which were copied, 
moved, re-ordered or deleted is 
shown. 

 
Some operations cannot be 
undone. For example, if a deleted 
document has been purged from 
the Trash, it cannot be restored. 
 
Also, depending on Security 
settings, most users may not be 
able to Undo a Delete.  This is 
because of recommended Security 
settings of Read Only on the Trash, 
except for one or two uses that will 
maintain the Trash. 
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Team Document Sharing and Inbox Review 
 

Emailing and Routing Primafact Documents via 

Outlook 

 

You can share Primafact documents quickly and easily as e-mail attachments.  E-mailing sends a 
copy of the document as a PDF file, although you also have the option of sending documents in 
TIFF format (which may be preferred for nuanced photos, for example).  
 
 

EMail a document  
(also see:  “E-mailing and Routing Multiple Documents” below): 

 
 Open a document, right-click on the page and select Mail > Email Document, or use the 

toolbar button to do the same. 

 A window will display. You can change the File Name – PDF format and All pages of the 

document will be included by default. 

 There is a tab at the top for PDF options. Click on this tab for more options. You can specify 

whether you want annotations included, or if it is a colour document, you can adjust 

compression size to make the file size smaller for emailing  (Note: to ensure photos sent 

as PDFs are sufficiently detailed, set the compression to no less than 40%.  Alternatively 

you can send photos in TIFF Format.)  

 Click OK. Your usual e-mail window will appear with the document attached. 

 Enter the recipient’s address and send your message as usual. When the recipient opens 

the attachment, the document will open up in their PDF viewer. (Documents sent as TIFFs 

will open in the recipient’s default image viewer application.) 

 
Note: Documents from Primafact can be dragged and dropped into an email you are currently 
creating in Outlook. 
 

Document Routing 
If the recipient is a member of your firm with access to Primafact, you should route the document 
instead of emailing it. (You can use e-mail if a staff member is offsite with no access to your 
network.)  
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Routing sends a shortcut to the networked document via an e-mail attachment, bringing you 
directly to the document (or specific page reference) in Primafact, keeping you connected to the 
system. (Alternatively you can send the document using Primafact’s Messaging tool). 
 
To ROUTE a document 

 Open a document, right-click on the page and select Mail > Route Document Reference, 

or use the toolbar button to do the same. 

 Your usual e-mail window will appear with an attachment featuring the Primafact icon.  

 Enter the recipient’s address and a message. Click Send. 

 
When the recipient opens the attachment, the document will open up in Primafact. 
 
 

E-mailing and Routing Multiple Documents 
 
Multiple documents can be e-mailed and routed from the Primafact Binder view: 

 
 Highlight the documents you wish to send. Right click and select Email or Route. (You can 

also click the e-mail or route icons in the toolbar. Or you can press CTRL+M to email or 

CTRL+R to export.) 

 If you are routing, the e-mail window will appear with separate attachments for each 

document you highlighted. 

 If you are e-mailing, you will see the Emailing a Document from Primafact dialog. You 

choose between sending Multiple PDF Documents or Single PDF Document from the 

Format dropdown. If you select Single PDF Document, all the documents you highlighted 

will be merged into one large document, with bookmarks automatically inserted on the 

first page of each document. The recipient will be able to navigate each document using 

the Bookmarks pane in Adobe Acrobat Reader. If you select Multiple PDF Documents, a 

separate PDF will be created for each of the highlighted documents. 

 Click OK on the dialog. Your usual e-mail window should appear with either one PDF 

attached or with multiple PDF documents attached, depending on your Format selection 

from step 3. 
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The Inbox  

Recognizing that document review often starts with the Inbox, we have created a dedicated 

Inbox feature with capabilities that include the ability to search and filter documents in your 

Inbox, set preferred views, and manage inbox discussions for quick and convenient team 

document communications. You can create your own subfolders to organize inbox materials as 

desired. 

You can access your Inbox by clicking on the My Inbox Icon at the top of the Shortcuts bar: 

 

 

Viewing your Inbox 

Main Inbox 
The top level of your Inbox (Main Inbox) is designed to show you anything new that has been 

added to your Inbox.   

You can decide if you want your Main Inbox to also show the contents of any subfolders, or just 

the contents of the Main Inbox folder.  By default, Primafact shows the contents of the selected 

folder only, meaning no content filed in subfolders will be shown.   
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New Arrivals Indicator 
When new documents or messages arrive in your Inbox, your Inbox Icon will display the 

number of unread items appearing in your Inbox: 

 

Note: If your shortcuts toolbar is hidden or disabled, your inbox notifications appear at the 

bottom-left corner of Primafact. 

 

 

 

Identifying Inbox Folders with New Items 
Individual new folders with new items will also display a bolded 

title along with the number of items:   

We recommend you set aside time to check your Inbox regularly for new arrivals. 

NOTE - You can mark items “Read” or “Unread” by right-clicking on the item and selecting 

Mark Read/Mark Unread. 
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Refresh button 
We recommend you click your Refresh button from time-to-time to confirm you are viewing the 

most recent content in your Inbox.  

 

Searching your Inbox 
You can search and filter content in your Inbox. As with the binders, you can set your Inbox to 

complete Full-Text Searches, or Quick Filter searches.   

For guidance on how to use the filters, see Using Filters in Binders, above. Note the available 

filters will be slightly different in the Inbox. 

 

Filtering Inbox Content 
You can filter your Inbox as needed in the moment, and even preserve those filters in saved 

Views for quick future access.   

Primafact 6 has some built-in filters to make it easier to manage your Inbox content.  You can 

add views as needed.  See Customizing List Views for details on creating and managing List 

Views in Primafact. 

Our Creating Saved List Views video tutorial walks you through the basics of creating 

your own list views.  

  

https://www.primafact.com/primafact-6-tutorial-saved-list-views
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Pop-Out Inbox 

You can Pop Out your Inbox screen to view it alongside other Primafact windows.  This is 

designed to make activities like filing easier.  You can pop-out any Inbox folder, and other list 

views as well.   

To Pop Out your Inbox, select the Pop-Out button  on at the far right of the main toolbar: 

 

 

  

Popping out your Inbox 

screen into a new 

window makes filing 

easier, since you can 

view both locations 

side-by-side. 
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Adding Documents to your Inbox 

Documents may be added to Primafact Inboxes the same way you add documents to any 

location in Primafact.  This includes Dragging & Dropping, and Scanning to the Inbox if you have 

a compatible scanning configuration.   

You can also right-click on any document in Primafact and click the menu option, then select 

the recipient(s) who will receive the document in their Inbox: 

 

 

See Sending Documents to Other Users’ Inboxes below for guidance on sending documents to 

other users’ Inboxes. 

 

Adjusting Your Inbox Settings: Setting Up Your Inbox  

Note: For instructions on refining your Inbox List View, see Customizing List Views, below. 

 

Customizing your Tab Bar  
You can change the items on your Tab bar to provide quick access to the views that are most 

important to you.   

To customize your Inbox Tab Bar:  

1.   Click on the gear icon  at the far right of the blue Tab bar: 

 

2. The Tab Bar Options window will open. 
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3. Select the Views you wish to add or remove from the Tab bar using the  arrows. 

4. Position the View order using the  arrows.  

5. Click OK to save your changes. 

 

Change Inbox View – Folder Content  
Inbox View settings can be set at the User Level to allow you to see your preferred fields and 

formatting when you review your Inbox.  Changes to your own view settings will not impact 

other users.  

Adjusting Folder Content Displayed in Main Inbox Folder 

To change what Inbox Folder content (Inbox content only or Inbox + subfolder content) you see 

in the Main Inbox:  

1. Click the More View Options Dropdown button 

 

2. Select Modify View. 

3. The Modify Inbox Documents View window will open.  
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4. Change Show Documents In: selection to “Selected folder and subfolders.” 

 

5. Click OK to preserve your changes. 

NOTE: Primafact’s Default “Show Documents” setting is to show documents in Selected 

Folder Only.  

 

NOTE: Primafact’s Default “Show Documents” setting is to show documents in Selected Folder 

Only.  

You may make additional changes to your Inbox view using this window as described elsewhere 

in this Guide. 

 

Updating your Inbox View 
You can change your field display in your Inbox  

To do this: 

1. Click the View button and select Format Row. 
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2. The Format Row Appearance window will open: 

 

 

3. Select Profile Fields by clicking the Select Profile Fields button.  Use the arrows to add or 

remove fields from your display.   

4. Click OK to preserve your changes. 

5. To position your fields, use the up and down buttons (if you do not see both, they will 

appear as you select an item further down the list. 
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6.  Formatting for the selected field appears at the right. 

 

Formatting List Fields 

7. You can change text attributes (color and size) for the selected field on the right hand 

side of the Format Row Appearance window. 

8. To conserve space on lists, text fields, such as Notes, offer the option of showing an 

information icon instead of text: 

 

9. Select your chosen icon using the dropdown. 

 

10. Click OK. 

11. Add any filters, if desired. 

 

Saved Views: Saving your View for Future Use 

To save your view for use as a “Saved View”: 

1. Click the View button and select Save View. 
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2. The Save View button will appear. 

 

3. Name  your view.  You can set this view to Personal visibility (meaning only you will see 

this view), or Public visibility, which makes this view available to other users.  

4. Save your view when complete. 

 

See Customizing List Views below for more details on formatting Saved List Views. 

NOTE – Be careful if creating a new view using an existing view as you have the option of 

overwriting the current view with the new settings. 

 

Viewing Other Users’ Inboxes 

You can view documents in other users’ Inboxes and Inbox folders.  We do not recommend that 

you complete your own document reviews while viewing another viewer’s Inbox. 
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Selecting Visible Inboxes 
You can select which users’ Inboxes are visible to you in Primafact.  

To choose which User Inboxes are visible: 

1. click on the Select Visible User Inboxes button on the Inbox Toolbar: 

 

 

2. The Select Inboxes window will open. 

 

 

3. Check the User Inboxes you want to have visible in the Folder view.  (Your own Inbox will 

not be visible on this list, as it is viewable by default.) 

 

4. Click OK to save your selection. 
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Viewing another User’s Inbox (“View As”) 
To view another User’s Inbox, you will be viewing content from the perspective of that user.  

You can tell you are in another user’s inbox, because the Blue Tab Bar will change to a shade of 

purple and the other user’s initials will appear on the left-side of the Tab Bar. 

 

Note – You do not have an Unread option available when “Viewing As” another user.  

 

Document  Review Workflows: Reviewing Documents 

within your Inbox 

Primafact Inboxes are designed to make it easy to review your documents right within your 

Inbox.  In addition to search and filter features, the Primafact Inbox has a number of review 

supports, including “For Review” marking, a dedicated Notes field and a team Discussion tool. 

Watch our video tutorial on Document Intake and Review Workflows. 

 

 

 

Early Case Assignment - Assigning Documents to a Case before Filing 
The Early Case Assignment tool lets you assign documents to a Case from the Inbox before 

filing in a Case binder.  This allows you to use Case coding tools while a document is awaiting 

review within Inbox, allowing users to effectively complete document reviews and coding as 

soon as a document is received.  

Assign your document to a Case: 
1. Select the Document(s) in the Inbox. 

2. Select any of the first four tabs in the preview Window. 

https://www.primafact.com/intakereview_workflows
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3. Start typing part of the Case Name in the Case area to display matching options. 

 

 

4. Select the desired Case. 

 

5. Click the Assign button to assign to the Case. 

 

 

6. Once assigned, the Case field will turn Grey.  

 

 

7. Clicking the dropdown button beside the binder icon will display all locations where the 

document can be accessed in Primafact.   Clicking any of the listed locations will take you 

to that binder or folder in Primafact.  (This is a single document; all locations contain 

copies of that document.) 
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8. Now you can apply any Case coding to your document. 

NOTE – When the document is filed in a Case Binder in Primafact, the document copy will be 

removed from the Unfiled folder in that Case. 

 

Sending Documents to Other Users’ Inboxes  
You can easily move documents to other Users’ Inboxes, or send copies to other users for filing 

or review while the document remains in your Inbox, allowing concurrent review for multiple 

users.  

To Send Documents to a Single User 

To send to a single user, you can drag and drop the selected document(s) from your Inbox into 

the other user’s Inbox.  A dialog will appear, giving you the option of moving or copying the 

document.  You can add a message, Mark “Urgent,” and/or “For Review” 

Clicking Copy will keep the document in its current location and deposit a copy (linked to the 

same document) in the recipient’s inbox.  Clicking Move will transfer the document to the 

recipient’s Inbox. 
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Send a comment to multiple recipients at the same time:  

1. Select your document & drag to a single user inbox 

2. To add recipients, Type your Message in the new comment window at the bottom of the 

discussion tab.  Use the @ key on your keyboard or the blue @ button to select recipients 

(as you type names, matches will appear. Click on the name on the menu to select.  

3. Add comments if you wish. 

4. You may also mark documents Urgent or For Review. 

5. Clicking Copy will keep the document in its current location and deposit a copy (linked to 

the same document) in the recipient’s inbox.  Clicking Move will transfer the document 

to the first recipient’s Inbox, and copies of the same document to other recipients’ 

Inboxes. 

 

Sending A Message (Document Discussions) 

Send a comment to multiple recipients at the same time:  

1. Select your document 

2. Click on the Discussion tab 

3. Type your Message in the new comment window at the bottom of the discussion tab.  

Use the @ key on your keyboard or the blue @ button to select recipients (as you type 

names, matches will appear. Click on the name on the menu to select.  
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4. Add comments.   

5. Adjust the page if you wish to direct the recipients’ attention to a different page. 

6. You may also mark documents Urgent or For Review. 

7. NOTE – Documents sent using the Send to Inbox menu item stay in your Inbox after 

sending. If you wish to delete from your Inbox you will need to delete after sending to 

other users.  They remain selected after sending so are easy to identify. 

 

Directing recipient to a specific page 
You can direct your recipient to a specific page of your document by right-clicking on the page 

in the Preview area, right-clicking and selecting “Send to Inbox” from that page.  The document 

will open on that page in the recipient’s Inbox.  

Document Discussions Tab 

All messages on a document appear on the Document Discussions Tab. You can send a message 

to another user by entering their initials in the To area near the bottom of the Tab. 

 

 

Opening at specific page 

You can direct recipients to a specific page by entering the destination page in the Page area 

before hitting Send. 
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Adding Persistent Notes and Instructions 
You can add a more persistent notes and instructions by entering them in the Notes area on the 

profile field, or other field that your team has designated for Instructions. 

You can set this field to appear on your Inbox view, either as a text field, or as an [i] icon, which, 

when displayed, indicates content has been added to that field. 

See Updating Your Inbox View for details on how to make Notes visible on your Inbox List.  

 

Marking a Document “For Review” 
You can mark your own documents “for Review” or mark for review by another User when 

sending them a document.  

Review Indicator 

Documents marked for review will have the reviewers’ initials displayed on the first four 

Preview and Profile Tabs when viewing the document Preview. Reviewers’ initials appear on 

the Profile Tab when viewing the Open document in the Normal View. 

 

 

• Initials in Gold (JZ in this image) indicate a document is marked “For Review” for that 

user, but not marked done.  

• Initials in Green (KJ in the above image) indicate a document has been marked as 

reviewed by that user. 

 

Marking a Document for Your Own Review  
To indicate that a document requires your own review, click the dropdown arrow beside the 

Inbox Icon on the Preview Tab (Profile Tab on an Open Document). 

Click Mark for Review. 
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Your initials will appear in gold.   

 

Marking a Document for another User’s Review 
When sending a document to another User, select the “For Review” button on the Drop/Paste 

Documents window.   

 

The document will be marked for that user’s review when sent.  To mark a document for 

multiple users’ review at a time – see Sending Documents to Other Users’ Inboxes. 

 

Marking a Review Done 

To mark your review Done, click the checkmark button to the right of the Inbox icon.  Your 

gold initials will turn green, and the document will no longer be marked “For Review.” 
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NOTE – Clicking the checkmark button will mark the item as “done” by you, and add your initials 

in green, even if you did not mark the document “for review” before clicking the checkbox.  

 

Changing a “Done” review back to “For Review”  

To return your reviewed document to “For Review” status, click the checkmark button to 

the right of the Inbox icon.  Your initials will be changed to gold, and your document will be 

returned to the “For Review” list. 

 

Unmarking a Document For Review 
To unmark a document for your review, click the click the dropdown arrow beside the Inbox 

Icon on the Preview Tab (Profile Tab on an Open Document). 

Click the Unmark for Review option.  Your initials will be cleared.  (You will need to do this 

twice if your initials are displayed in green.) 

 

 

Inbox Filter: For Review 
You can quickly filter to your Inbox items marked “For Review” by you (and not marked done) 

by clicking the “For Review” Button on the blue Tab Bar located at the at the bottom of the 

Inbox. 
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See  Marking a Document “For Review” for more details on this feature. 
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Working with Annotations for Document 

Review and Analysis 
 

About Annotations 

Annotations are designed to identify important document content, and to capture notes and 

coding that make it easier to review your materials as the case progresses.   

You may use annotations to: 

✓ Highlight important parts of a page, just as you would use a highlighter on a paper page 

✓ Highlight important parts of a page and add your analysis, or assign an Issue 

✓ Summarize handwritten text that cannot be OCR’ed 

✓ Redact sensitive content (See Redactions) 

 

Annotations incorporate coding tools, including Annotation Event Date, Favorability, as well as 

Color labels and Issue labels that can be set up by your firm to enable standardized coding for 

consistent review as a case progresses. 

Annotations are designed to stay confidential to the firm, as solicitor’s work product. By default, 

they are not emailed and they can never be included in a Published CD. However, you can choose 

whether or not to include them when exporting to certain formats, including PDF and printing. 

 

Creating an Annotation 
 

 Identify an area you wish to annotate. (This can be done in an open document or from 

the preview pane). 

 Holding the left mouse button down, drag the mouse down and right until the box 

surrounds the area you wish to highlight.  Release the left button when you have 

highlighted the area. A dialog box will appear. 

 Type in your notes as desired (this text can be changed or added to later.) If you do not 

enter any text, the annotated area will still be highlighted.  

 Select your annotation type (Analysis is the default). 
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 Add your Issue(s) as applicable. 

 Fill in any of the additional fields as desired. 

 Select the T button to insert any document text that appears beneath your annotation 

area (this applies to OCR’d text only).  

 Click OK. Your annotation will appear in the annotation list shown in the Annotations tab. 

 

Simple and Expanded Annotation Form 
The Annotation form appears when you create a new annotation, or click on an existing 

annotation (within the document area) to edit.  This form allows you to record information for 

future recall and analysis.  

Primafact 6 Annotation Forms support uniform visual coding, along with dedicated fields to 

support quick assembly of Chronologies, Discovery Outlines and other reports. The annotation 

form can be expanded to capture more information.  Clicking the Show More / Show Less 

button at the bottom-right corner of the Annotation form will expand or limit the display.  

Annotation Forms also offer automation options for more efficient coding. 

 

Simple Form:      Expanded Form 
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Fields on Annotation Form: 

Labelled Color Coding  

Primafact now includes up to 18 colors, which can be labelled by 

the firm for more uniform coding and more visual identification 

when viewing documents and binders.  

Why use this field?  Color-coding annotations with standardized 

colors & labels makes it easier to recognize the broader category of 

an annotation for more efficient Case preparation.  Annotation Coding tools help to break down 

annotation content into manageable and relevant groupings for downstream Case preparation 

and analysis.  

 

Event Date & Time 

The Event Date field is displayed at the top-right area of the 

Annotation Form.  It is designed to support event chronologies.  

This dedicated field is designed to preserve the date (and 

optionally, time) of the annotated content as it would appear in a 

chronological record of Case events.  

Why use this field? Completing the Event Date (and optionally, the 

time) on an annotation form enables swift assembly of Case Chronologies.  

Issue Coding  

Using Issues allows you to add nuance to your Annotations for 

more granular filtering and reporting.  You can apply multiple 

issues to a single annotation, making it easy to cross-reference 

annotations, or use for multiple reports.  For example, you 

could create Issues for multiple witnesses, to pull together 

examination preparation lists for each witness – even where a 

production is applicable to more than one witness. This lets you create a simple annotation for 

everyone.   

Embedding Annotation Issues in Case Templates to more efficiently leverage document 

standards across Caseloads. 

Why use this field?  Issue coding allows more subtle categorization of Case Issues for refined 

analysis and reporting.  
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Favorability Coding 

Dedicated favorability buttons (thumbs-up  and thumbs-

down ) make coding for adversarial value efficient and 

highly-recognizable.  You can filter annotations by adversarial 

value to quickly assemble materials marked as notably helpful 

or adverse to your case. 

Why use this field?  Thumbs-up and thumbs-down buttons are 

instantly recognizable when viewing documents and binders – document views display the 

thumbs-up and thumbs-down codes right on the document, for instant identification when 

reviewing materials.  You can filter annotations by adversarial value to quickly assemble 

materials marked as notably helpful or adverse to your case, making preparation for 

negotiations particularly efficient.  

 

Fields Found on Expanded Form: 

Clicking the “Show More” button at the bottom right of the 

simple Annotation Form expands the form to reveal additional 

fields. 

Text Excerpt 

The Text Excerpt Field, found on the Expanded 

Annotation Form, is a dedicated location to house 

the verbatim excerpt subject of the annotation. 

You can auto-populate any OCR’d text in this field 

by clicking the T button below the bottom right-

corner of the Text Excerpt field.   

Why use this field?  Designed for building reports, 

the Text Excerpt field provides a distinct area to 

house text citations, distinct from reviewer comments 

in the Annotation Notes field.  
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Annotation Author 

This field records the team member who has 

created the Annotation.   

 

Annotation Date 

This field records the date the Annotation was 

created.  (This is distinct from the Annotation 

Event Date, which tracks the event date of the 

subject litigation). 

 

Annotation Type 

Optional Field – Defaults to Analysis.  Dropd-down options include Fact, Handwriting, Highlight, 

and Question 

 

Report Author 

Tracks the originator of the document content.  For example, the doctor who writes a medical 

opinion. 

 

Page Image 

This area shows the annotated page in Primafact, and you can scroll to view convenient 

annotation context. 

 

Redactions 
Redactions block out sensitive document content that you do not wish to share with outside 
parties. 
 

In Primafact, redacted text is visible through a dark grey transparent box. You can choose to 
output redactions in black or white by selecting the appropriate option when printing, e-mailing, 
exporting and publishing documents.  Redactions are automatically applied to documents 
exported from Primafact using the PDF export and Primafact Publish tools. 
 

Creating Redactions 

 Create redactions as you would an annotation - identify an area in the document page 

you wish to redact. Place your mouse in the top left corner of the area to redact. Holding 
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the mouse button down, drag the mouse down and right until the box surrounds the area 

you wish to redact and then release the left button when you have highlighted the area. 

 The Annotation form will open.  Select the Redaction button at the bottom of the form.  

 

You will notice the form header change in color to dark grey. 

 Press the "OK" button to preserve your redaction. 

 

Annotation Efficiencies 
Annotation Automation tools, including Annotation Templates and Annotation Repeat tools 

are designed to make repetitive coding more efficient.  

Annotation Copy 

Copy Annotation Content to another Annotation 

Use the Annotation Copy button to copy instantly copy Annotation content into another 

Primafact Annotation.  Coding is copied, except for Annotation Issues and Annotation Text 

fields. 

1. Open the annotation you wish to copy. 

2. Click the Copy button. 

 

3. Click OK to close annotation. 

4. Create new annotation in desired location. 
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5. Click Paste Annotation button. 

 

 

6. All copyable fields will populate the current annotation. 

7. Click OK to save and close. 

 

Annotation Repeat 

The Annotation Repeat tool makes repeat annotations, such as identifying references to a 

specific issue, quicker and more efficient.  You can repeat with or without the annotation 

dialog.  (Repeating with the annotation dialog works well when you want to repeat specific 

fields and add additional annotation-specific coding.  Repeating without the annotation dialog 

works well when you want to repeat coding and quickly move on.) 

Using Annotation Repeat 

1. Open an annotation form (this can be a new or existing annotation). 

2. Populate the fields you wish to repeat. 

3. Optional – Select Fields to Repeat   

a. Click the Start Repeating dropdown button > Select Fields to Repeat button to 

select which fields you will repeat from the available options. 
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b. Check the desired items from the Annotation Auto-Repeat Options checklist.  

Click OK.  (Primafact will use the last selection if you do not select fields to repeat.  

Primafact will use the default selection if you have never selected fields to 

repeat.) 

 

4. Repeat with or without Annotation Dialog: 

a. Repeat with Open Annotation Dialog:  

i. Click Start Repeating  

ii. Create a new annotation.  Annotation Form will open with selected fields 

populated.  Update as desired.  Click OK to save and close. 

iii. Annotations will continue to open with selected fields repeated until 

Repeat is stopped. 

b. Repeat without opening Annotation Dialog 

i. Click Start Repeating dropdown  

ii. Click Start Repeating without Annotation Dialog 

 

iii. Create a new annotation.  Annotation will be created with selected fields 

populated without form opening  
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iv. Annotations will continue to be created with selected fields repeated until 

Repeat is stopped. 

v.  

Stopping Annotation Repeat 

When you are ready to stop repeating your Annotation, click the green Stop Repeating button 

at the top-right of your Primafact window. 
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Deleting Annotations 
 

You can delete annotations you no longer need, but be careful – there is no “undo” button to 

restore deleted annotations. 

To delete an open annotation: 

Open Annotation form: click the “Delete this Annotation” button at 

the bottom-left corner of the Annotation form. 

On Annotation Lists: Select your annotation(s). Right click and select “Delete Annotation.” 

 

Reviewing Annotations 

Viewing Annotations 
Quick View: Hover your mouse over the annotation you wish to view. An  will appear;  

hover over the . The contents of the annotation will appear in a yellow box below your mouse. 

You can also open an Annotation by clicking on it (either on the document or on an annotation 

list) to see the entire Annotation. 

Annotation information can also be reviewed on the Annotation List, and on the Annotation Tab 

of an open document, or on the Annotation Tab of a document viewed in the Preview pane. 

 

Browsing Annotations  
Annotated documents are identified by a small colored box to the left of the document name in 

the binder view. 

Within an open document, you can move to the next or previous 

annotated page by clicking one of the yellow arrows on the Primafact 

toolbar.  

Pages with annotations are identified by a yellow square in the  

thumbnail view.  

 

 

! 
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Hiding Annotations 
You can show/hide annotations and other markup when viewing documents in a Tab or 

separate window in Primafact.  See Adjusting Markup Display on a Document in Primafact for 

details. 

 

Annotation Lists and Reports  

The Annotations List 
The Annotations List is a collection of all annotations on a Case.  Filtering the Annotations List 

allows you to limit displayed annotations to specific annotated content for focused review. 

Annotation Lists can be easily filtered and sorted, and you can format lists to display desired 

content in your preferred order.  You can save lists to enable easy access to formatted and/or 

filtered annotations to accommodate different review requirements – for example you may 

create a view for an issue chronology, and a different view to track witness preparation lists or 

diagnostic findings.  

Annotation Lists can be exported in various formats, including Word and Outlook. 

Note: You can create custom Annotation List views to precisely set the columns and sort order of 

chronology reports exported to Word.  See Customizing List Views. 

 

Accessing the Annotations List 

The Annotations List view can be accessed by selecting the Annotations option on your Blue 

Case ribbon.  You must select a Case Binder to access the blue Case Ribbon.  
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Annotation Filtering 

Annotation filtering can be accomplished by a combination of the terms you type in the Quick 

filter and the options available in the Filter drop-down, offering considerably more flexibility in 

determining the scope of Annotations identified in a search.   

Filters may be applied cumulatively, allowing you to filter by any or all filter categories at a time. 

HOW FILTERS ARE AGGREGATED:  Primafact applies “and” coding for multiple coding values:  e.g. 

selecting Pink Annotation Color and Favorable:  Displays results with BOTH values (must be coded 

pink and favorable) 

Multiple selections within a coding variable (e.g. annotation color) – will be an “or” selection, 

identifying annotations coded with any of the selected colors within that variable. 

 

Annotations Toolbar 

The Annotations toolbar features a number of tools to help filter and review annotations.  

  

 

 

The Case Dropdown allows you to display all annotations in a Case 

or display only annotations found in the selected binder 

 

 

 

 

The Quick Text Filter filters to annotations including your specified 

text.  Note only fields appearing on your List will be searched.  (For 

example you might be looking for “Lee,” a Report Author.  If Report 

Author is not a displayed field on your list, this annotation will not 

be identified. 
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*NOTE the Annotation List Quick Text Filter only searches 

Annotation Content, and not text in the associated document. 

 

The Home View button returns you to your default Annotation 

Home List View 

 

The Saved Views button allows you to instantly switch your list view 

screen to the format of a Saved View, or to save and format new 

views 

 

The Annotation Color Dropdown Filter allows you to filter to 

annotations coded by selected color(s) 

 

The Issue filter allows you to filter to select Annotation Issues  

 

The Favorability dropdown allows you to filter to annotations 

coded with adversarial values 

 

The Importance filter allow you to filter to annotations marked 

Important 

 

The Date filter allows you to filter by Annotation Event Date 

(Including Before and after the Date of Loss assigned to your Case)  

 

The Current Document button filters to display only other 

annotations on the same document as your selected annotation  

 

The Trash button deletes your selected annotation(s).  *NOTE: You 

can’t restore deleted annotations.  
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The Additional Filters dropdown allows you to filter and group your 

displayed annotations by a number of additional attributes, 

including Binder and Tab location 

 

The Grouping icon (beneath the  filter) features a dropdown 

that allows you to sort the displayed annotations in groupings such 

as Color, Document or Author.  To clear the sort, select “No 

Grouping.”  The dropdown menu also includes expand  and 

collapse  icons that you can use to expand and collapse all 

displayed groupings. 

 

The Export button lets you export lists to Word, Outlook and Excel 

and other formats   

 

This button pops out your list into a separate Primafact window. 

 

  

Hide/Show Preview will reveal or remove the document preview 

pane from the Binder View. 
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Create Chronologies and Reports  
Comprehensively and consistently annotating your Case 

documents means more effective future preparation. 

Applying structured annotation coding makes it possible to 

pull together detailed reports in moments, for efficient 

preparation and review as your case progresses.  

Reports are assembled using the Annotation List View, and 

can be easily exported to Word, Export, Excel and PDF.  

You can create highly customized reports in a table format, 

based on your requirements.  Report examples include: 

• Detailed Chronologies 

• Issue Chronologies 

• Discovery / Witness Preparation Charts  

 

VIDEO TUTORIAL: Create a Case Chronology 

Watch our video tutorial for tips on creating your own Case Chronology annotation 

list view. 

 

 

Start with the Annotation List View 

Reports are assembled using the Annotation List View, which can be accessed by selecting the 

Annotations option on your Blue Case ribbon.   

 

Assembling your Report 

To display the specific content required for your Report you will typically filter and sort the 

Annotations appearing on your List. 

To change the displayed annotations from the content displayed by default, you can filter and 

sort.  You can also use saved Views to quickly apply pre-set Annotation List formatting and 

filters.  See Customizing List Views, below for details on customizing your List View to display a 

custom report formatting and filters. 

When you have your Annotation List filtered and sorted into the desired content and 

presentation, you are ready to export your report.   

 

Create customized 

Annotation List views 

for quick and precise 

control over the 

appearance and order of 

exported reports and 

chronologies. 

 

https://www.primafact.com/primafact-6-create-chronology
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Exporting Lists & Reports 
You can export a list to preserve or share your report, in various formats.  For a static easily-

shared list, Word and Outlook are often preferred, while Excel is recommended for users who 

will be extensively manipulating these exported lists.  The Evidence Brief assembles a PDF of all 

pages appearing in the List along with the associated annotation, for context. 

 

Export to Word  

To export your displayed Annotation List to a Word table 

1. Click the Report Dropdown and select Copy to Clipboard (for Word) 

 

 

2. Paste into your Word document. 

 

Create a Chronology 

Assembling an Event chronology requires the Event field to be completed on your Annotation 

forms.  Event chronologies use the date in this field to sort by date. 

 

If your list is sorting by another column, you can sort your Event Date column to present your 

annotations in chronological order.   
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Simply click on the Event Date column to sort your displayed annotations in ascending or 

descending date order. 

 

 

 

If your displayed view does not include an Event Date column, switch to a view that includes 

the Event Date by clicking on your View Selection Dropdown.  

 

 

To add an Event Date column to your Annotation List, you can adjust your List Formatting to 

include different field selections and ordering.  See Customizing List Views, below.  

To export your chronology to Word use the Report Dropdown, as detailed in Export to Word. 

 

Filtering by Date of Loss 

Primafact includes a built-in DOL filter that allows you to filter to events occurring pre-DOL, or 

on and after the DOL.  To use this tool, the DOL must have been entered into the Case 

Summary.  

To filter a List by Date of Loss: 

1. Select the Event Date filter on your Annotation List 

 

 

2. The Annotation Event Date Filter dialog will appear. 
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3. Click the appropriate checkbox to filter to dates before or after the Date of Loss, as 

applicable: 

 

 

4. Click OK to apply filter and close dialog. 

 

Customizing List Views 
Creating multiple List Views in Primafact makes it easy to switch list displays at the touch of a 

button for more relevant case viewing and report assembly.  Customizing views makes it quick 

and easy to suit your precise needs when viewing Case materials in Primafact. 

Views can include specific fields and formatting, as well as pre-set filters for quick and 

consistent list presentation. 

One major benefit of customizing Annotation List views is that it enables you to precisely select 

the data fields and sort order appearing in your exported reports and chronologies. 

This section shows how to work with Annotation List Views, but these instructions also apply to 

setting views for other lists including your Inbox and the Document List View. 

VIDEO TUTORIAL: Saved List Views 

Watch our video tutorial on creating Saved List Views. 

 

 

One benefit of 

customizing Annotation 

List views is precise 

control over the 

appearance and order of 

exported reports and 

chronologies. 

 

https://www.primafact.com/primafact-6-tutorial-saved-list-views
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The Home View (Default List View) 

The Home View is the default view that you view when you first open a List view. You can 

change your home view if you prefer to see a different default display.  You can quickly reset 

your display to the home view by clicking the home view button at the top of your list toolbar. 

 

To change your Home View see Change Your Default Home View, below. 

 

Creating a New View 

You can create custom views to display your lists with your preferred fields, formatting, filters 

and sort tools. 

1. To avoid overwriting an existing view, start by saving your new view.  Click the View 

Dropdown on your list toolbar: 

 

 

2. Click Save View. 
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3. Name your view and add a description for future guidance.   

Visibility: Click 

Personal if you are 

creating the view for 

yourself or Public if 

you wish to create a 

view for other users.   

Apply to: Click All 

Cases to use this view 

in other Cases.  Apply 

to This Case will make 

this view available to 

this Case only.  (Case 

views can be copied to 

other Cases using the 

Updating Existing Cases 

Using Case Templates 

feature) 

You can complete this step once you have finished creating your View, but doing this step 

first helps to preserve existing Views without unintentionally changing existing settings. 

 

Formatting your View:   

1. To format your current view, click the View dropdown on your List toolbar and select 

Format View. 
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2. The Format Row Appearance dialog will open. 

 

This is where you can specify which fields appear on your list, the order of your list 

columns, and row formatting (size, color etc.)  

 

3. Selecting Columns appearing on your list: To select which columns appear on your List 

click the Select Profile Fields button on the Format Row Appearance dialog.  
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4. The Select List Columns dialog will open. 

5. Click items from the columns and use the blue arrows to add or remove fields from your 

List.   

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Note: You can include fields from other areas of 

Primafact (such as System fields including Team Flags 

and document Reviewer Information, or other Profile 

Categories by using the Profile Group Dropdown to 

change your Profile Field selection options: 

 

 

 

TIP: If you are 

creating a view for 

export to Word, 

keep in mind the 

number of columns 

that will 

comfortably fit on 

your page when 

adding columns to 

your view 
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6. Once you have selected your fields, click OK. 

Note: Reports and Chronologies export to Word in Table format. If you are creating a view 

for export to Word, keep in mind the number of columns that will comfortably fit on your 

page. 

 

7. Next, on the Format Row Appearance dialog, use the blue up and down arrows to 

position your fields in the desired position on your list – items from top to bottom are 

displayed from left to right on your list.  
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8. To Change Column Formatting, such as changing text color or size, click on the field name 

and make your column formatting selections on the right hand side.  In this example, I am 

making the author column text bold and pink for quick visual identification: 
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Save your View.

 

 

9. If you are Saving updates to an existing list, select the Overwrite View option.   

If you are saving a New view, name and save as a New View, completing the Visibility and 

Apply to fields.  

 

 

Additional View Formatting – Sort Order, Groupings and Filters 

To specify your list’s sort order (essential for chronologies), as well as applying groupings and 

additional filters, you will need to use the Modify Annotations View dialog.   

1. Click the View dropdown and select Modify View. 
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2. The Modify Annotations View dialog will open. 
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3. Adjust your settings as desired.  Click the Descending checkbox to sort in descending 

order (e.g. Z-A, or most recent items on top. 

4. Click OK to apply and Save your settings to your Saved View. 

 

NOTE: You can also select Profile Fields, format Row Appearance and visibility using the 

Modify Annotations View dialog, so if you are creating  a very detailed List View, it can be 

helpful to start with this screen after creating your view.  

 

Change your Default Home View 

You can select any of your Saved Views to appear as your Home View on your List Screen, to 

make it convenient to access your most frequently-used view settings. 

1. Click the View Dropdown on your list toolbar: 

 

 

2. Select Manage Views. 
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3. The Manage Views dialog will open. 

 

 

4. Click the Make Home View button.   

Click Yes to proceed and set your new Home View. 

Note: If your selected view is an All Cases view, this will reset your Home View for this List 

Type across all Primafact Cases.  (This will not impact your Inbox Home View Settings. 

If your selected view is a Case view, this will reset your Home View for this Case only.  (If 

this setting is applied to a Template, the home view will be applied to Cases based on the 

Template, unless reset by the User.) 

Resetting your own Home View settings will not impact other Users.  

 

5. Clicking the Home button will open your new Home View.  

 

 

 

Annotation Batch Updates 
You can now update multiple annotations on a single Case in the same operation using the 

Annotation List.  This is a good way to update large numbers of annotations if you are using 

new coding values.   

You can use this option to  

✓ replace or amend certain values (e.g. turn light green annotations to mid-blue) 
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✓ update other fields (e.g. find green annotations and add favorability coding) 

You can update: 

✓ all annotations 

✓ all filtered annotations 

✓ selected annotations (selected using CTRL+ select or SHIFT+ select) 

 

 

Be careful when Batch Updating – there is no utility to automatically revert back to prior coding 

if you make a mistake.  Firms may wish to limit personnel permitted to perform batch updates, 

and by default most users are restricted from using this feature unless specifically enabled. 

 

To perform a batch update: 

1. Filter your Annotations to the items you 

wish to update (in this example we’ve 

filtered to all of our Case annotations coded 

green): 

 

2. Optional: Select specific annotions from this 

list (if desired). 

 

 

 

 

3. Click the Gear icon on the bottom-right corner of the 

Annotation screen: 

 

 

4. Select Annotations > Annotation Batch Update 

 

! 
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5. The Annotations Batch Update will appear. 

 

6. Choose which annotations you wish to update: 

a. “All annotations in current list” means all annotations in your current view, 

which may be filtered 

b. “Selected annotations” means annotations you have manually selected using 

CTRL+select or SHIFT+select  

7. Choose the field you wish to update using the dropdown:  
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8. Next select the updated value (options will vary by field selected) 

 

Remember - in this example, we want to take all of the annotations coded “green” and make 

them “favorable.”  We have filtered to “green” and are now updating the favorability field to 

“favorable.” 

 

9. Repeat step 7 on the next value if desired.  (e.g. I may wish to take all the green annotations 

converted to favorable and change the color to something else, like yellow or blue). 

 

Assembling Productions 
Primafact 6 includes several features designed to more conveniently assemble materials for 

sharing outside the firm right within Primafact.  features include  

✓ Binder Index Copying or printing binder indexes makes it easy to preserve a 
record of binder content, and can make it easy to create Indexes 
and Affidavits of Documents in MS Word. 
 

✓ Binder Page 
Numbering 
 

- Allows page numbering to be applied to entire Binders, Tabs, or 
Sections in a single operation.  Numbering is dynamic, so if content 
is moved, numbering adjusts to reflect changes. 
 

✓ Stamps - Allows you to apply headers, footers and watermarks to individual 
documents.  Stamps are static until changed.  You can adjust when 
a stamp is published in the stamp settings. 
 

✓ Highlighting - Looks like a standard highlight, to direct attention to specific 
content and  designed for export 
 

✓ Linking - Allows linking to content outside Primafact (e.g. external websites, 
such as CanLii Case citations  
 

- Allows linking to Primafact Content (in the same exported 
document or Tabbed PDF) 
 

✓ Title Aliases Add up to 5 alternate Document Titles to efficiently meet document 
naming requirements for court submissions – this preserves 
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preferred document names without needing to duplicate new 
documents for other purposes 
 

✓ Binder Bundles - New Binder type designed for export; includes title alias selection 
for exported document and document sets 
 

✓ Bates IDs - Allows teams to assign persistent identifiers to individual pages in 
a Case.  Applied to full documents, or multiple documents at a time.  

 

Setting Up Your Productions 

Copy Binder Index  
 
Primafact makes it easy to create an Index of documents, such as an Affidavit of Documents or 
List of Documents for use in Word. 
 
To copy a Binder Index: 

1. Select the desired binder in the Explorer 
View.  

 

You can also select a tab or section in a 

binder to copy the index from. 

 

  

2. Right-click anywhere in the binder and 
select Copy Index. This copies the binder 
index as unformatted text to the 
Windows clipboard. 

 
  

3. Start a new document in Word and paste 
the text. You can then edit as required. 
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Binder Page Numbering  
Page Numbering allows you to quickly and easily number all documents in a selected binder or 

tab continuously from 1 on the first page of the first document the last page of the final 

document. (You may exclude documents from being numbered, but cannot selectively number 

pages using this feature.)  

When activated, page numbering is applied to all documents within a binder (except documents 

you exclude), and is dynamically updated as documents are added, removed or reorganized 

within a binder.   

Numbering is displayed as #ON or #OFF in the blue bottom 

ribbon of your binder.   

All edits to Page Numbering are saved and take effect 

immediately. 

 

Managing Page Numbers 

You have a number of options for numbering your binders: 

• Restart numbers on each document 

This starts each document at Page 1 

e.g. In a 4-document tab with Document 1 (4pp) Document 2 (3pp), 

Document 3 (1p) Document 4 (7 pp) the pages would be numbered as: 

 

Doc 1: Pages 1-4  

Doc 2: Pages 5-7  

Doc 3: Page 8        

Doc 4: Pages 9-18  

 

• Number tab from top to bottom 

This numbers each document within a Primafact tab starting at Page 1 of the 

first document, continuing without interruption across documents. 

e.g. In a 4-document tab with Document 1 (4pp) Document 2 (3pp), 

Document 3 (1p) Document 4 (7 pp) the pages would be numbered as: 
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Doc 1: Pages 1-4  

Doc 2: Pages 5-7  

Doc 3: Page 8        

Doc 4: Pages 9-18   

 

• Restart numbers on each section 

This numbers each document within a Primafact section starting at Page 1 of 

the first document, continuing without interruption across documents, 

similarly to “Number tab from top to bottom”. 

However, with this option, numbering restarts at Page 1 on the next section. 

 

Turning Page Numbering On  

Page numbering can quickly be turned on by clicking the numbering area at the far right of the 

blue bottom navigation ribbon.  (If numbering has not been turned on, you will click # OFF to 

open the Page Numbering Setup window). 

 

 

 This will bring up the Binder Page Numbering Setup Window. 
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 Select (Click) the Enable Page Numbering for Binder checkbox.  Click OK. 

 

Applying Page Numbers to a Binder 

 

1. Open the Binder Page Numbering Dialog by right-clicking in the binder and selecting 

Page Numbering > Setup.  

 

 

2. Select the Advanced tab on the Binder Page Numbering Setup dialog. 
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3. Click the Enable Page Numbering for Binder checkbox. 

 

4. Select the Numbering Option from the Options dropdown (See Managing Page 

Numbers, above, for an explanation of how these selections work) 

 

5. Below Options, select the page where your page numbering should begin.  

 

6. In the appearance area, enter your text, including desired auto text fields: 

 

Page Number 

Number of Pages 

Document Title 

 

7. Select the Position in the Page Position Area (the buttons indicate the location on 

the page where the number will be displayed - #3 is top right, for example. 
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8. Select your preferred font and font size in the Font area.   

 

9. Select Apply and OK to stamp your document. 

 

 

Separately numbering a Tab 

 

 On the Advanced tab on the Binder Page Numbering Setup dialog, select the desired Tab: 

 

 

 

 

 

 

 

 

 

 

 

 Select the Customize button in the numbering area.   

 Select desired page numbering configuration described in Applying Page Numbers to a 

Binder, above. 

 You may use the same Parent appearance, or adjust the appearance of your numbering 

by selecting Customize in the Appearance Area. 

 Click OK to apply your number stamp. 
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Excluding Pages from Being Numbered 

Primafact will allow you to select specific documents from a binder, and exclude them being 

automatically numbered. 

Keep in mind that the total number of pages in the document will not be included in the total 

number of page of that document set. (It’s like an invisibility cloak – the document is there, but 

the numbering system doesn’t notice).  

 

To exclude pages from being numbered: 

1. Click on your selected document. (If you wish to select several, select these by 
pressing the Ctrl key as you make your selections.) 
 

2. Right Click to bring up the drop-down menu. 

 

3. Select Page Numbering > Exclude Document(s). 

 

 

 

 

 

 

 

 

 

To include previously excluded pages in your numbered document set 

If you change your mind and decide a document should be included in the document set, you 

may bring it back in using steps similar to those detailed above: 

 Click on your selected document. (If you wish to select several, select these by pressing 

the Ctrl key as you make your selections.) 

 Right Click to bring up the drop-down menu. 

 Select Page Numbering > Include Document(s). 
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Turning Page Numbering Off 

Page Numbering for any binder may be turned on or off at any time.  Turning numbering OFF 

allows you to print or publish documents without numbering.  You may turn on page numbering 

again at any time.  The numbering will revert to the stamp setup previously created for the Binder 

(though this may be edited as desired.) 

 

To turn off Page Numbering: 

 

 Click the # ON area in the blue bottom navigation ribbon. 

 

 Simply de-select (uncheck) the Enable Page Numbering for Binder checkbox on the 

Binder Page Numbering Setup Window.  Click OK. 

 

 Page numbering will be temporarily disabled.  

NOTE: Turning Page Numbering Off is different from “Clear Numbering” (button at the bottom 

left-corner of the window), which will remove all the number formatting you have applied to 

the binder. 

 

Stamps 
 

Stamping lets you include additional text information on Primafact documents without affecting 
the original images. A stamp can include information such as the document title, page numbers, 
and watermarks. Stamps may be located in a number of positions on the page, and on selected 
pages within a document.  
 

Stamping a Document 
 

! 



 

©2022-2024  Sandcat Software Inc.  Working With Primafact 6     127 

Adding page numbers: Open a document and select the "Stamps" tab in the right pane. Click the 
"Add" button at the bottom. The Stamp Document dialog box will appear. 
 

 
 

 In the Stamp Text section, add the desired text.  Icons beneath this area allow you to add 

fields such as Page Number and Document Name. 

 In the Apply To area, select your desired page range. 

 In the Font section choose your desired font, size and attributes. 

 Choose page position – each radio button corresponds to a location on the page. (Postion 

1 is the top left corner of the page; Position 8 is centered at the bottom of the page.) 

 Determine Print and Email appearance. (Choosing “Never” for Email means the stamp will 

not appear if you email the document; stamping “Never” for Print means you will not be 

able to apply the stamp to printed documents, even if you select stamp printing in your 

printer dialog.) 

 Click OK. 

 

Adding a Watermark 

 Select Position 5 in the Page Position area to make the watermarking option available.  

 Rotate 310° to position your stamp diagonally across the page. 

 Your stamp text will appear as a transparent watermark image on your document page(s). 
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Deleting a Stamp 

Select the stamp from the list in the Stamps tab and click on the Delete button. 

 

Adding Highlights 
You can add highlights to your documents in Primafact 6 to call attention to key 

content.  Highlights are a colored transparent overlay that can be exported along with 

documents shared in PDF format. You can elect to include or exclude highlights when 

exporting your documents as PDFs.  

Using the highlighting tool to add a highlight: 

1. Open your document.  

2. Select the Highlight tool from the markup options on your toolbar. 

 

3. If desired, use the Highlighter dropdown to select a different highlight color. 

4. The highlighter tool will appear. 

5. Draw one or more boxes around the text you wish to highlight. (Highlight boxes can be 

selected and resized.) 

6. Click to set highlight.  

Highlights appear as transparent linear overlay over document content: 

https://www.primafact.com/primafact-6-highlights
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7. When you have completed highlighting reset markup tool to pointer or annotation 

setting: 

 

 

Adding Links 
You can add links to your Primafact documents to other Primafact document 

locations and to online resources outside Primafact.  Links can be used within 

Primafact and included in PDF exports from Primafact.   

Links to Primafact documents only export if the linked documents are included in the 

exported document or bundle.   

Links to Primafact document locations 

Using the linking tool to add a link to a Primafact location: 

1. Open your document on a Tab or separate window.  

https://www.primafact.com/primafact-6-links
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2. Select the Linking tool (the document markup setting defaults to “create annotation”). 

  

3. The link tool will appear. 

 

4. Depress your left mouse-click button to draw a box around the area where you want to 

insert your link.  

 

5. The Create Link dialog will open.  

 

6. You have the option of Creating a PRIMAFACT link or a WEB link.  If linking to a Primafact 

document, click the Create a PRIMAFACT link checkbox. Adjust the color if desired. 

 

7. Click Next. 

8. Add a link note if desired.  



 

©2022-2024  Sandcat Software Inc.  Working With Primafact 6     131 

9. Navigate to the desired location in Primafact where your link will lead. 

10. Click Set Link. 

 

11. Link will be set to the specified Primafact location.  
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Links to online locations (Web Links) 

Using the linking tool to add a web link (location outside Primafact): 

1. Open your document on a Tab or separate window.  

 

2. Select the Linking tool (the document markup setting defaults to “create annotation”). 

  

3. The link tool will appear. 

 

4. Depress your left mouse-click button to draw a box around the area where you want to 

insert your link.  

 

5. The Create Link dialog will open.  

 

6. You have the option of Creating a PRIMAFACT link or a WEB link.  If linking to a Primafact 

document, click the Create a WEB link checkbox. Adjust the color if desired. 



 

©2022-2024  Sandcat Software Inc.  Working With Primafact 6     133 

 

7. Click Next. 

 

8. Add a link note if desired.  

 

9. Specify the web link URL address.   (Primafact will support Chrome’s link to highlight 

feature, to direct link to a specific web page location, such as specific CanLii paragraph 

citation.) 

 

10. Click OK. 

 

11. Link will lead to specified external link location. 

 

Opening Links inside Primafact 

Opening links on an open document  

1. Right-click over Link location and click Open Link. 

 

Opening links in the document Preview  

1. Left-click on Link and select Open Link.  

 

Adjusting Markup Displayed in Primafact 

You can show/hide markup when viewing documents in a Tab or separate window in Primafact.  

See Adjusting Markup Display on a Document in Primafact for details. 
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Bates IDs 
Bates IDs assign a unique, static identifier to pages in a case.  The purpose of Bates IDs is to 

uniquely identify pages for evidentiary purposes regardless of where they appear.  Accordingly, 

the Bates IDs will be the same even when a document appears in multiple binders.  Only one 

Bates ID may be applied to any page. 

Bates IDs are applied at the document level (to all pages in a document) rather than on a page-

by-page basis.  If you merge Bates ID’d pages into a different documents, the Bates ID’d pages 

will retain their original Bates numbering. Because the Bates IDs are persistent, it is possible that 

Bates IDs will not appear sequentially in a document. 

A file must be converted to a Case before Bates IDs can be used. 

 

Setting Up Bates IDs 

The default format of Bates IDs is a simple number that is unique across all documents in a case. 

(e.g. 000001).  A Bates ID may only be used once in any Case. 

For advanced number scenarios, it is possible to create multiple numbering sequences for a case 

that include prefixes. Bates IDs are unique within prefixes, so for example it is valid to have both 

a P-000030 and D-000030 page in a case. When applying a Bates ID a sequence must be selected. 

Only a single Bates ID can be applied to a page. 

Bates IDs are not available in a case until they are set up.   

 

Applying Bates IDs to Documents 

Bates IDs may be applied to single documents, multiple documents, or full binders at one time.  

Each page will be assigned a unique, static Bates ID.  You may not apply Bates IDs to single pages 

within a larger document, but you may move (merge) Bates ID’d pages to documents without 

Bates IDs on all pages. 

 

To apply a Bates ID: 

 Within the Binder View, select your document(s), right-click and select Productions > 

Bates ID’s > Apply Bates IDs from the drop-down menu. 

 The Apply Bates IDs window will open. 
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 Select the desired Bates ID sequence, and documents where the Bates numbering will be 

applied (entire binder or selected documents. 

 Once you are satisfied with your selection, select Apply. 

 The next available numbers in the Bates ID sequence will be applied to your document(s). 

 

Identifying Documents that have Bates IDs 

You may see which documents in a binder have Bates IDs by right-clicking in the binder and 

selecting View > Show Bates Icons from the drop-down menu. 
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Documents with Bates IDs will be displayed with a Bates icon  in the left margin: 

 

 

 

NOTE:  This selection replaces the Annotation Icons view.  You can only see Bates icons OR 

Annotation icons at one time in the Binder view. Annotation icons can be replaced using the 

same drop down menu. 
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Clearing Bates IDs 

 

Clearing Bates IDs is performed using many of the same steps used to apply Bates IDs.  However, 

you will clear the Bates ID instead of applying.  NOTE: Once you clear a Bates ID, it cannot be re-

used and is unavailable to the Case in the future. 

 

To Clear a Bates ID: 

 Select the document(s) in the Binder view.   

 Right click, and select Productions > Apply Bates IDs from the drop-down menu.  

 Select Apply to Entire Binder or Apply to Selected Documents in the Apply Bates IDs 

window. (Be careful, as once cleared, this action cannot be undone!) 

 Select Clear. 

 

 

Exporting from Primafact 
There are many ways to export content from Primafact.  Publishing tools make it easy to 

assemble and share organized briefs. 

 

Upload to Portals  

You can now upload documents to browsers directly from Binders and Inbox folders2.  This 

eliminates the “extra step” of dragging documents from Primafact to a local folder before 

exporting to locations in the Cloud. 

VIDEO TUTORIAL: Portal Uploads 

Watch our video on uploading documents from Primafact to online portals. 

 

 

 
2 Requires a supported browser. 

https://www.primafact.com/portal_uploads
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Copy Documents to Browsers and other locations outside Primafact 
To copy documents directly to browsers or other locations outside Primafact, including 

Windows Explorer location: 

1. Select your documents 

2. Click the Export Button  

3. A separate window will appear.  Drag the Green box to your target window. 

 

4. Confirm your upload. 

5. Close the Upload from Primafact window. 

If you are sending very large documents, it may take a moment for your documents to be ready.  

You can continue working in Primafact as the documents are prepared for sharing. 

 

Bundle Binders 

The Bundle Binder is a new Binder setting designed for sharing documents with 

entities outside your firm. It is particularly helpful for efficient creation and export of 

court submissions, including CaseLines submissions.  A Bundle Binder is identified as 

light purple (rather than blue). You can set Binder as a Bundle Binder without losing any regular 

binder functionality.  

The Bundle Binder setting makes it easier to access many e-brief production features including: 

✓ Multiple Title Aliases, allowing you to assign more than one title to the same document, 

so the document can be renamed instantly depending on where the document will be 

submitted (e.g. Firm Document Standards and CaseLines titles can be applied to the 

same document) 

✓ Copy binder to Tabbed PDF – Similar to the feature available in Primafact 5, but 

designed to be more efficient 
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Apply Bundle Binder Setting to a Case Binder 
1. Right-click your Case Binder 

2. Select New > Bundle Binder 

  

3. Name your binder, and add Tabs, Sections and Documents as applicable. 

 

 

Export a Bundle Binder as a PDF 
Primafact 6 has updated the PDF export tool to support easy exchange of organized, multi-

document tabbed briefs.   

Now you can more efficiently export a structured document set in 

a single tabbed PDF, including: 

• Bookmarks to each document 

• Binder Page Numbering 

• Alternate document Titles  

• Highlights (if desired) 

• Primafact links to other documents in the bundle 

• Web links  

• Bates IDs where applicable 

• Annotations (if desired) 

Large files can be easily uploaded to CaseLines, online portals, document exchange tools and 

other locations outside Primafact. 

  

PDF bundle binders preserve links  

to other document locations  

in your bundle 
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To export your bundle binder as a PDF: 

1. Click the Binder-to-PDF button at the top of the Bundle Binder 

    

2. The Saving from Primafact window will appear 

 

File name defaults to 

name of Binder.  Rename 

if desired. 
 

Change destination 

folder if desired by 

clicking browse button 
 

Single PDF file selection 

will create a single 

tabbed PDF with 

documents ordered as 

they appear in your 

Bundle Binder  
 

Document titles default 

to Title set selected in 

Binder, but you can use 

dropdown to select a 

different set of alias 

titles. 
 

Other options may be 

included as desired 
 

Click Open in Explorer 

checkbox to immediately 

access your saved PDF. 
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3. Select the desired output and click OK when complete.  

Note:  To upload individual documents, see Upload to Portals. 

 

Exporting Binders as PDF without the Bundle Binder Setting 
You can save any binder to PDF format to create easily-shared tabbed briefs, even if you’re not 

using the Bundle Binder setting.  

By default binders are saved as a single PDF.  If Page Numbering has been turned on for the 

binders, this numbering will be included in the saved PDF.  (Page Numbering can be turned off 

prior to saving to PDF if desired). 

To export a regular binder as PDF: 

1. From the Productions menu in the top toolbar, select Export Binder as PDF. 

 

 

 

 

 

 

The Binder Save window will open.   
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 Select where you will save the folder in the Folder area, and how you wish to format your 

Binder (Multiple PDF files or Single PDF File).  To create a single bookmarked document 

select Single PDF File.  If saving as a single PDF file, you have the option of renaming your 

file in the File Name area. 

2. Check the Open in Explorer when complete checkbox to open your exported PDF in 

Windows Explorer when your exported PFD is ready. 

3. Click OK to export your PDF. 

Note: Redactions are always included in Binders saved to PDF. Annotations are not 

included by default but can be included by checking the Annotations checkbox. 



 

©2022-2024  Sandcat Software Inc.  Working With Primafact 6     143 

Export Select Documents as PDF 
If you do not wish to export an entire binder, you can select specific documents, tabs and 

sections to export in a single PDF operation. 

 Select the documents you wish to export 

 

 Right-Click and select Save As from the context menu  

The Save window will open.   
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 Select where you will save the folder in the Folder area, and how you wish to format your 

Binder (Multiple PDF files or Single PDF File).  If you are saving as a Single PDF file, you 

have the option of renaming your file in the File Name area. 

 Check the Open in Explorer when complete checkbox to open your exported PDF in 

Windows Explorer when your exported PFD is ready. 

 Click OK to export your PDF. 

Note: Redactions are always included in Binders saved to PDF. Annotations are not 

included by default but can be included by checking the Annotations checkbox. 

 

Using Title Aliases 

VIDEO TUTORIAL: Title Aliases 

Primafact 6 Title Aliases allow you to assign more than one title to a document at the 

same time.  This means a document can have more than one name, which is helpful 

when circumstances require you to name a document differently than your preferred 

document name in Primafact, such as naming court submissions. 

https://www.primafact.com/primafact-6-title_aliases
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Publish to Folder or Media 

The Publish tool packages your documents with a built-in viewer which allows the recipient to 

view all the documents on a PC without the need to install Primafact software. Linked documents 

(e.g. Microsoft Word files, MPEG videos) can be included in the package, but require that the 

recipients have the necessary software installed on their computers. 

 

What gets published, and what doesn’t: 
When you export documents using the Publish tool, the output content is a bit different from 

the PDF output options. The table below shows what is included in Published   

output: 

Always Included: Optional: Never Included: 

• Documents included in the 
folders you select 

• Redactions 

• Searching capabilities 

• Profile fields (metadata) 

• Bates IDs 

• Binder Page Numbers 

• Annotations 

 

Publishing Directly to CD/DVD 
 

1. Insert a CD/DVD into your drive 
 

2. Select Tools > Publish to Folder or Media 
 

3. The Publish Primafact Folders dialog will appear 
 

4. Select the folders, binders, tabs, sections or documents you wish to publish 
 

5. Click OK 
 

Selectively Publishing Documents 

To publish or to exclude specific documents from a folder, display the document pane and select 

the desired documents.  Click on the Documents icon in the top right of the window to select or 

deselect individual documents.  
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The status bar (bottom left-hand corner of the Publish window) shows how much space and how 

many discs the published documents require. This is an estimate. 

 

 

 

 

 

  

 

 

Publish to a specified folder 
If you wish to save your Published file to your network, you will want to publish to a specified 

folder.  This save option is typically used when you plan to share your document via link to a 

document portal. 

1. Create and name a new folder in Windows Explorer where you will publish your 

Primafact file.  This will be referred to as your “target folder” in the steps below. 

2. In the Publish to area, select Specific Folder. 

3. Select your target folder using the dropdown in the Publish to area of the Publish 

window.  Click the folder button to navigate to your desired destination. 

4. Publish steps are the same as when Publishing directly to CD/DVD above, 

Note: Primafact will only publish to an empty folder.  You will need to create your target 

folder BEFORE you complete Step 3 above. 

 

Sharing a Primafact published file via Document Portal 

You will need to Zip the file before uploading to your document portal for sharing.  The 

recipient will need to unzip the file to open or import to their own Primafact installation. 

If you do not have a dedicated Zip tool and you are using Windows Explorer, you should be able 

to Zip your file by right-clicking on the Primafact Publish folder and selecting Send to > 

Compressed (Zip) Folder. 
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Importing documents received in Primafact Publish format 
Documents received in Primafact Publish format use a dedicated import tool that preserves the 

organization of the published file.  See Importing a Primafact CD (Primafact Publish Import)  for 

details on using this tool.  

 

  



 

©2022-2024  Sandcat Software Inc.  Working With Primafact 6     148 

Printing from Primafact 

Print a document open in Primafact 

 
1. Right click on the page and select Print or click the Printer icon the toolbar, or press 

CTRL+P 
 

2. Select a printer from the dropdown menu. 
 

3. Select the pages: you can print all the pages, the current page, or a range of pages. 
 

4. The Content options in the lower left of the dialog are Primafact-specific. 
 

• If Page Image is checked, the scanned images (the content) will be printed. 
 

• If Annotations is checked, the annotation highlights are printed on the page image. 
The size of the printed page image may also be reduced to allow space to print the 
annotation details (date, author, and comments). 

 
If Page Image is not checked, Annotations can still be checked. Doing so will cause all 
the annotation details to be printed, without printing the page images. 

 

• If Stamps is checked, the stamps will be printed on top of the page image. 
 

Note that the size of the printed page image may be reduced to allow space for the 
stamps on the page. 

 

• It is possible to Print documents without including Redactions.  If the Redactions 
checkbox is checked (recommended), all redacted areas in the document will either 
be blanked out or blacked out depending on whether White or Black is selected. It is 
very important that this box be checked for documents going outside the firm to 
protect privileged information. 
 

5. There are two Special options you may choose: 
 

• Use Print as One Job if you are printing multiple documents, they will be sent to the 
printer as one big batch. 

 
This can be used if multiple copies of many small documents are being printed, and 
you want them collated. 

 
This can also be used if you are printing many small documents to a shared printer, 
and you don’t wish your documents to be interspersed with other people’s print jobs. 
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• The Conserve Memory checkbox only works when colour images are being printed. If 
a document prints but shows blank pages, try selecting this option. 

 

Print all of the documents in a binder/tab/section/subsection 

 
a) Select the first document you wish to print 

 
b) Scroll down the window until you see the last document you wish to print - hold down 

the Shift key and left click on this document 
 

c) Right click on any of these selected documents and select Print > Print Document(s). 
 

Print selected documents in a binder/tab/section/subsection 

 
a) Select the first document you wish to print 

 
b) Hold down the CTRL key and left click on the desired documents 

 
c) Right click on any of these selected documents and select Print > Print Document(s). 

 

Check the Print Status 
 
Primafact does its printing in the background. This means you can keep working while printing 
proceeds. You can even keep adding print jobs to Primafact’s print queue. If there is an error 
while printing, you will not be notified. You have to check the Print Status to see that all your jobs 
printed properly. You do this by pressing CTRL+ALT+P, or select File > Print Status from the main 
menu. 

 

Primafact 6 Team Coding Customizations 
Primafact 6 enables more customizable settings for coding, including annotation colors and 

labels, annotation default form settings, and team flag colors and labels. 

Global System-Level Customizations 

Customizing Annotation Color Labels 
Customizing Annotation Color Labels makes it easier to standardize annotation color coding. 

1. In the main Primafact Toolbar, select Tools > Setup > Annotation Colors. 
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2. The Annotation Color Labels window will open. 

 
 

You will see 12 colours.  Click Show Additional Colors to make 6 additional colours available. 

Select the colors you wish to use by clicking the checkbox to the right of the selected color.  

Enter the color label in the text area of the selected color.  

Click OK. 

Now you have set your Annotation Color system defaults. 

 

Customizing Global Team Flags 
Team flags are colored document-level tags used to identify documents at the Case level.  

Similar to Profile Fields, they can be used to identify documents by attributes such as type of 

document, document content, and document status.  Applying labels to Team Flags helps 

ensure their use is standardized across the team. 
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NOTE: Changes made to global labels are automatically 

applied to all cases across Primafact unless your case is set 

to override the Global settings.   

It is a good idea to carefully determine a Team Flag’s label 

before applying it as a global setting, as changes can create 

confusion and incorrectly tagged documents. 

 

Customizing System Default Team Flag Labels 

1. In the main Primafact Toolbar, select Tools > Setup > 

Team Flag Labels. 

 

 

2. The Default Team Flag Labels  window will open.  

 

If you wish to “lock down” the 

current Global Team Flag Label 

settings on a case (so that case 

labels are not automatically 

updated when changes are 

made to the Global values), 

open the Case Team Flag 

settings and select Override for 

the Case. 

! 



 

©2022-2024  Sandcat Software Inc.  Working With Primafact 6     152 

3. Enter the desired label in the field to the right of your flag.  

 

4. Click OK to save. 

 

 

System-Wide Annotation Form Default Settings 

You can now customize default annotation values.  An example would be opening Annotations 

to a different color than yellow.  Setting annotation defaults can be done at the system level 

(globally, for all users), and at the Case level (for all users while using that that Case). 

 

Adjusting Annotation Defaults – Global Settings: 
 

1. To change your firm’s global setting, go to 

Tools > Setup > Annotation Templates 

 

 

 

 

2. The Manage Annotation Templates window will open. 
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3. Select the template you wish to use as your default. 

4. Select Set as Default. 

5. Confirm your selection 

6. Click Close to complete. 

 

Customizing Profile Fields 
 

A profile field represents one piece of metadata which can be associated with a document, for 
example, a document date. A profile category is a group of profile fields. Primafact allows you to 
enter data in any profile field in any profile category. Clients can create their own custom 
category and use existing fields or create new fields. 
 

Creating and Modifying Profile Fields 
 

The user interface for setting up profile fields and categories is called the Profile Management 
Window. To access it, select Tools → Setup → Profile Fields from the main menu. 
 

You may want to create a category for your firm, to include only those specific fields you’ll use. 
 

Creating a Category 
1. Select the Categories tab.  
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2. Click on “Add a new category”.   

You will now see the full window (see 
step 3). 

 

 
3. Click on “Add a new category” in this 

window. 
 
 

4. Enter a descriptive name for 
“Selected Category” in the top right, 
for example “Medical”. 

 

 

5. Click on “Add or remove fields in this 
category…” to bring up the Select 
Fields to Include dialog. 
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6. Select a field in the left pane, and 
click the right arrow to move it to the 
right pane. You must include 
Document Date in every category, so 
start with that. 
 

7. Continue adding fields you want to 
the list on the right. If you add a field 
by mistake, highlight it, then click the 
left arrow to move it back to the list 
on the left. 

 

8. Click OK when done. 

 

  

9. The fields you selected now appear 
under the selected category. Click on 
the up and down arrows to change 
the order of the fields. 
 

10. Click OK to save the changes and 
close the window. 

 

11. Click Apply to save the changes 
without closing the window. 

 
 
Creating a New Field 
 
1. Click on the “Profile Fields” tab. 
 
2. Click on Add a New Field. The new field is created – rename it in the Selected Field box. 
 

• In Column Views - this 
description is used when the 
profile field is displayed in the 
list view on the Explorer tab 
 

• In Exported Lists - this 
description is used when 
exporting document data to 
CSV format file. 
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If blank, they will default to the description next to Selected Field when needed. 

 
3. Select the Field Type from the drop-down list.   The 

following types are available: 
 

Text Accepts a single line of alphanumeric text. 

Memo Accepts multiple lines of alphanumeric text. 

Dropdown Appears as a drop-down box containing a list of 

values you specify. 

Number Accepts numbers only (no decimals). 

Date Accepts date input only. Appears with a drop-

down calendar button. 

Time Accept time input only. Appears with a drop-

down time button. 

Float Accepts decimal numbers. 

Currency Accepts numbers with two decimal places. 
 

 

 

4. Select the categories which should include this field. You 
should see your new category and ensure it is selected. 
 

5. Click OK or Apply to save the changes. 

 
 

Changes made to profile fields will not show up in any documents which are already open in 
Primafact. Primafact must be closed and reopened for changes to be visible. 
 
Document Date Field 
 
There is one profile field which cannot be changed and cannot be deleted: Document Date. This 
is a special field which Primafact uses for display and sorting of documents. 

 

Configuring Title Aliases  

Why Use Title Aliases? 
Primafact 6 supports up to 5 sets of Title Aliases per Case.  Title Aliases allow you to have more 

than one document title for each document, so that you can review and share the same 
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document using different names that suit distinct use requirements, such as CaseLines 

document naming protocols.  Among other advantages, title aliases can make document 

duplication unnecessary when done for the sole purpose of complying with court naming 

requirements. 

Title Aliases can be set up at the Global level for ease of use on any Case, but you can override 

global defaults to set up custom Title Aliases for individual Cases 

Auto-Generating Title Aliases 
You can configure Title Aliases to auto-generate based on Case and Profile-field level attributes 

so that your documents get named according to content in that field.  If using Auto-Generates, 

your team will need to ensure that applicable profile fields are populated with accurate data 

(an empty field will yield an “n/a” output for that field). 

Setting Up Profile Fields 

It helps to determine how documents will be named in a title alias, then to use (or create) 

Profile fields to correspond to the intended output.  A Title Alias Category can make it easier to 

populate specific fields when applicable to your document. 

If you wanted your output to look like: 

1. Factum – Respondent Doe – 8-SEPT-2024  

you would want to set up the following profile fields: 

● “1.” ………………………..… [Document Number - Custom Profile Field (Number)] 

● “Factum” …………………. [Document Description - Custom Profile Field (Text)] 

● “Respondent” ………..… [Party Role - Custom Profile Field (Motions) or  

Existing Field on Summary Screen (Main Action) (Text)] 

● “Doe” ……………………….. [Party Name - Existing Field on Summary Screen] 

● “8-SEPT-2024” ………….. [Document Date - Existing Field (Document Date)] 

See Customizing Profile Fields for details on configuring Profile Fields 

 

Configuring Auto-Generating Title Field 

1. System default Title Aliases can be configured in the global settings by clicking 

Tools > Setup > Document Titles 
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2. The Default Document Titles window will open:  

 

 

3. Click the checkbox beside the Title Alias you wish to set to auto-generate: 
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4. This will activate the Template area: 

 

Name your Title (if you wish): 

 

5. Click the Add Profile Field button 

6. The Select Profile Field window will open. 

7. Click the fields you wish to add and click the arrow button to add the selected field to 

your Template. 
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NOTE: If you select “Document Date” you will be prompted to select a date format.  You 

can adjust the date format manually by typing your preferred format, but may have to 

make a few adjustments to your template to achieve the desired output. 

You can also add your own text to the Template: 

e.g. Motion Record - %Tab #% - %Document Description% - %Document Date 

|yyyy-MMM-dd% 

 

Auto-Complete 

The Auto-Complete feature allows you to speed up text entry by setting up shortcuts that are 

converted to designated text within document titles and annotations. Auto-Completes can be 

used for more efficient and consistent document naming and mark-ups. 

Auto-Completes can be created for three types of use: 

✓ Globally (firm-wide, all cases)  

✓ Case-level (for specific Cases) 

✓ User-level (for your individual use) 

 

Creating Auto-Completes 
To create an Auto Complete: 

 Select Setup > Auto-Complete from the Tools menu.  This will open the Auto-Complete 

form. 

 Select the category/scope of the Auto-Complete that you are about to create (Global, 

Case List or User List). 

 Select the Add button.   

 The Add entry to Global list window will appear.  Create your desired Abbreviation and 

associated term. 

Once the Auto-Complete has been set up, you can use it to “auto-populate” any text field in 

Primafact, including document names and annotations. 
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Sharing Auto-Completes 
Personal or Case-Level Auto-Complete lists may be shared among users and Cases, using the 

Export and Import features detailed below.  To access these features, select the Advanced button 

on the Auto-Complete form.  The Auto-Complete Advanced window will appear.  You will use 

this window to export and import lists. 

 

Exporting Auto-Completes 
To use Case-Level Auto-Completes in other Cases (or to share User-Level Auto-Completes among 

other users or Cases), you will need to Export the desired Auto-Completes.   

To do this: 

 Using the Auto-Complete form, Select the desired list (Global List, Case List or User List) 

 Click the Advanced Button 

 Select Export this list 

The Export this Case list to file window will appear.   

 

Determine where you would like to save your file by browsing the Save in: area. 

 Name your file in the File name field. 

 The file will be saved as a CSV (Comma Separated Values) file in the Save as type: area.  

Do not change the file type.   

 Click Save. 

 Your file is available for Importing. 

 

Importing Auto-Completes 
This is a quick way to assemble Auto-Completes using existing setups. 

Auto-Completes can be imported to other Cases and Users.  First, the desired Auto-Completes 

must be exported (see Exporting Auto-Completes, above). 

 

To import an Auto-Complete file: 
 Open the Auto-Complete Form using the Tools > Setup > Auto-Complete drop-down 

menu described under Sharing Auto-Completes, above. 
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 Select the desired list (Global List, Case List or User List) 

 Click the Advanced Button. 

 Select Import a saved list. 

 The Import a Case List from file window will open. 

 Browse and select the desired file (this will always be a CSV file). 

 Click Open. 

 Your file will be imported to your selected list.  If there are any duplicate entries, these 

will be identified and ignored. 

 

 

Case-Level Customizations 

Case Annotation Customization 

Customizing Case Default Annotation Labels 

If you want to customize your Annotation Color Labels for a specific Case: 

1. Open any Case Binder. 

2. Click the gear icon at the bottom-right the Primafact Window: 

 

1. Select Annotation Labels. 

 

2. The Case Annotation Labels screen will open.  
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3. Select Override default. 

 

4. Add or rename any color that you wish to customize for the Case.  (Colors that you do 

not rename will retain the default system labels.) 

 

5. Click OK. 

Note you can copy values from another Case by clicking Copy from Another Case button, 

selecting the desired Case and clicking OK, then Yes to confirm. After the Case values have 

been copied, you can continue to customize your current Case labels as desired. 

 

 

Customizing Annotation Case-Level Defaults with Case Templates 

You can set default values for individual Cases, overriding global annotation defaults and 

annotation templates for that Case.  Using Case Templates can help preserve standardization 

for values applied to individual cases, while allowing for variances across Case types. 

To change default annotation settings for a Case: 

1. Click on the gear icon at the right-corner of the Case ribbon: 
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2. Click Annotations > Annotation Templates on the drop-down menu: 

 
 

3. If you have not activated Case-level templates, the template override warning will appear.  If you 

click “Yes” the Case Templates will disconnect from the Global templates3.  

 

  

 
3 You can reset back to Global templates but will lose any Case template customizations.  (Any existing annotations 
made using the Case template settings will be preserved.) 
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4. The Manage Case Annotation Templates dialog will appear.  Select Default Annotation Values and 

click the Modify button. 

 
 

5. The Annotation Template Definition will open.  

 
 

 

6. Set your field preferences and click OK.  This works similarly to the settings for the global default 

annotation values, except you have the added option of adding Issues to the default Case 

annotation settings. 

 

 

7. Your default annotations will open at the set values for this specific Case. 
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8. Click Modify. 

 
 

9. The Annotation Template Definition will open.  

 
 

 

10. Set your field preferences and click OK. 

 

 

11. Your default annotations will open at the set values, unless you have set a different annotation 

for specific Cases. 
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Customizing Annotation Forms 

Annotation Form Customization (Event Time) 

To add or remove the Event Time field from the Annotations forms on a Case, click the Gear 

icon at the far right of the blue Case Ribbon and select Annotation Colors.  Select the 

Annotation Fields tab. Select or de-select the “Event Time” checkbox and click “OK.” 

 

 

 

Customizing Ref Labels  

Reference labels allow you to add extra form fields to customize tracked annotation 

information.  

1. To customize Ref Labels for a case, select the Gear icon from the far right of the blue 

bottom navigation ribbon.   

2. Select Annotations > Annotation Options 

3. The Annotation Options form will open 

4. Select Show Reference Fields on Options 

5. Specify your label for the predefined reference fields. 

6. Your defined Reference field labels will now appear on Annotation forms associated with 

your Case. 

 

Customizing Case Default Team Flag Labels 
 

To customize your Team Flag Labels for a specific Case: 

1. Open any Case Binder. 

 

2. Click the gear icon at the bottom-right the Primafact Window: 



 

©2022-2024  Sandcat Software Inc.  Working With Primafact 6     169 

 

3. Select Team Flag Labels 
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4. The Case Team Flags window will open. 

  

5. Select Override for this case. 

6. Enter the desired label in the field to the right of your flag.  This will overwrite the 

system default and apply your label to the Case. 

7. Select OK to save.  
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Customizing Title Aliases for the Case 

If your Case needs Title Alias Customizations that differ from the Global settings, you can 

override Global settings and apply customized Title Aliases for the Case.   

To customize Case Title Aliases:  

1. Access the Case Titles settings using the gear icon at the right corner of the blue Case 

Navigation Ribbon  

2. Select Document Titles from the menu.  

3. The Case Document Title window will appear:  

 

4. Click the Override button. (Notice the current Global Default values are displayed. These 

may be retained for your current case, modified or overwritten. Any changes will not 

impact the Global Settings.)  

5. Select the Title series you wish to customize.  

6. Rename the Title  

7. Check the Generate Automatically checkbox to customize auto-generated content. 

8. Add desired text and/or select Profile Fields. See Auto-Generating Title Aliases for details.  
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Customizing Team Flag Labels 

You can customize Team Flag labels to diverge from Global Team Flag label settings. You may 

choose to preserve some Global labels and customize others, or apply completely customized 

Team Flag Label settings to your Case.  

NOTE: Overriding Global settings divorces case Team Flag settings from Global settings. If you 

choose to customize any Team Flag label, any Team Flag label still using the Global Team Flag 

label name will not update along with any updates to that Global level Team Flag setting.    

To customize Team Flag labels for the case:  

1. Access the Case Titles settings using the gear icon at the bottom right corner of blue Case 

Navigation Ribbon  

2. Click on the Gear icon and select Team Flags from the pop-up menu. 

3. The Team Flags window will appear. 

4. Click the Override for this case button to customize Team Flag labels for the case.  

 

5. Rename any flag colors you wish to reassign to new label values for the case. 

 

Using Case Templates to Apply Label Values to your Current Case 

Case Templates can include customizations to label values, making it quick to update an 

individual Case to a set of standardized settings that diverge from Global Settings. 

You can apply settings from a Case Template, or from other Cases.  

***To apply Case Template settings to the Current Case 

NOTE: When you override Global settings on a Case,  your Case will not automiatically update  

 

Managing Bates IDs 

Setting up the Bates ID Master List 

 

Access the Bates Master List using the Gear icon at the bottom-right of the blue Case Navigation 

ribbon :   
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 Click on the Gear icon and select Manage Bates IDs from the pop-up menu. 

 The Manage Bates IDs window will appear: 

 

 

 

Add a new Bates ID sequence using the Add button, or modify an existing Bates ID sequence using 

the Modify button. 

 

Adding a Bates ID sequence 

 

 Select Add from the Manage Bates IDs form. 

 The Add a New Bates ID Sequence screen will appear.   
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 3.  Enter the name, any Prefixes, Prefix Delimiters (a hyphen is available) the desired start 

number, and any desired Suffix/Suffix Delimiter. 

 NOTE: Any Bates ID in this sequence may be used only once.  The same number (e.g. 

000001) can be used with multiple Prefixes, resulting in a unique Bated ID for each. 

 The Bates ID’s Visual Appearance may be modified by selecting the Visual Appearance 

button. This area functions much like the Stamp interface, allowing you to select font, 

font size, and page position. (The middle position is unavailable).  

 Select OK to save your new Bates ID sequence. 

 

Modifying a Bates ID Sequence 

To modify a Bates sequence, open the Manage Bates IDs screen.  Select the desired sequence 

and click the Modify button.  Changes to the Bates ID sequence format (position, font, font size 

etc.) will apply retroactively to existing uses of that sequence.    

 

Primafact Administration 
Trash 

Managing the Trash folder  
During training users are told to empty the trash regularly. There should be only one or two 
people in a firm that have this ability. This is set up in the Primafact security module.  
 
You can find out who has full access to the trash: Click on the Trash Folder, then right click. If you 
see “Delete” or “Empty Trash” as options, then you have Full Access to the Trash. Users who have 
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Read Only access will not see either of these options. If everyone can see the Delete and Empty 
Trash options, please contact Primafact Support to set up Security on the Trash.  
 
The trash should be purged routinely to avoid “bloating” your database with discarded materials.  
 
We also recommend clients organize the trash by the date things were put in the trash and then 
deleting ONLY documents that are older than 60 days. (the Undo function shows actions 
performed up to 60 days ago – they will not be retrievable using Undo if purged from the trash.) 
 
There may be instances when documents are accidentally deleted from their folder or binder. In 
order to prevent someone from deleting them from the trash or emptying the trash altogether, 
it is best to restrict all Primafact users’ access to this folder (Read Only) and leave the 
management of this folder to one or two people who would be given Full Access.  
 
Please have your IT person call Primafact Support to set up or change Security on the Trash 
Folder. We recommend your IT person manages the Security on Primafact, with assistance from 
our Support technicians. 
 

Purging files from the Trash folder 

 Navigate to the Trash folder. 

 Because you will typically 

want to limit purging to 

older items, it will be helpful 

to sort items by Time of 

Arrival in the Trash. In the 

display window on the right, 

if you do not see a column 

titled “Arrival”, right-click 

on any column and select 

Customize Columns. 
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 In the new window, in the 

left side under “Profile 

Fields”, from the drop-down 

list, select “System”. See 

Area C, to the right 

 Next, in the list under 

“System”, select “Date and 

Time of Arrival in Folder”.  

See Area D 

 Click on the arrow pointing 

to the right to add this to the 

“Document List Columns” 

section. See Area E 

 Click on the UP or DOWN 

arrow on the far right to 

position the column now, if 

you like. See Area F 

 Click OK 

 

 Click on the newly added column to sort by the date and time the items were put into the 

trash. 

 

Document Size 

Single document size should not exceed 1,500 pages. If necessary, when scanning or printing to 
Primafact, do so in batches of 1,500 pages or less. Primafact can house documents over 1,500 
pages but larger documents can have issues with Indexing, extracting, merging and printing. 
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Contacting Primafact Support 
 9am-5pm EST Monday-Friday (excluding holidays) 
 

support@primafact.com 
Local Toronto:  416-531-0891 x 1 
Toll-free:   1-888-881-0891 x 1 
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